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SUMMARY  33 
In the age of immunotherapy and single-cell genomic profiling, cancer biology requires novel 34 
in vitro and computational tools for investigating the tumor-immune interface in a proper 35 
spatiotemporal context. We describe protocols to exploit tumor-immune microfluidic co-36 
cultures in 2D and 3D settings, compatible with dynamic, multiparametric monitoring of 37 
cellular functions. 38 
 39 
ABSTRACT 40 
Complex disease models demand cutting-edge tools able to deliver physiologically and 41 
pathologically relevant, actionable insights, and unveil otherwise invisible processes. 42 
Advanced cell assays closely mimicking in vivo scenery are establishing themselves as novel 43 
ways to visualize and measure the bidirectional tumor-host interplay influencing the 44 
progression of cancer. Here we describe two versatile protocols to recreate highly 45 
controllable 2D and 3D co-cultures in microdevices, mimicking the complexity of the tumor 46 
microenvironment (TME), under natural and therapy-induced immunosurveillance. In section 47 
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1, an experimental setting is provided to monitor crosstalk between adherent tumor cells and 48 
floating immune populations, by bright field time-lapse microscopy. As an applicative 49 
scenario, we analyze the effects of anti-cancer treatments, such as the so-called immunogenic 50 
cancer cell death inducers on the recruitment and activation of immune cells. In section 2, 3D 51 
tumor-immune microenvironments are assembled in a competitive layout. Differential 52 
immune infiltration is monitored by fluorescence snapshots up to 72 h, to evaluate 53 
combination therapeutic strategies. In both settings, image processing steps are illustrated to 54 
extract a plethora of immune cell parameters (e.g., immune cell migration and interaction, 55 
response to therapeutic agents). These simple and powerful methods can be further tailored 56 
to simulate the complexity of the TME encompassing the heterogeneity and plasticity of 57 
cancer, stromal and immune cells subtypes, as well as their reciprocal interactions as drivers 58 
of cancer evolution. The compliance of these rapidly evolving technologies with live-cell high-59 
content imaging can lead to the generation of large informative datasets, bringing forth new 60 
challenges. Indeed, the triangle ‘’co-cultures/microscopy/advanced data analysis” sets the 61 
path towards a precise problem parametrization that may assist tailor-made therapeutic 62 
protocols. We expect that future integration of cancer-immune on-a-chip with artificial 63 
intelligence for high-throughput processing will synergize a large step forward in leveraging 64 
the capabilities as predictive and preclinical tools for precision and personalized oncology. 65 
 66 
INTRODUCTION 67 
The evolution of different branches of medicine as experimental disciplines has depended on 68 
the ability to manipulate cell population and organ functions under controlled conditions1. 69 
Such ability has its roots in the availability of measurable models able to recapitulate 70 
processes happening in our body.  71 
 72 
In the age of immunotherapy and single-cell genomic profiling2, cancer biology needs to take 73 
advantage of emerging in vitro and computational models for investigating the tumor-74 
immune interface in a proper spatiotemporal context2, 3. 75 
 76 
The tumor microenvironment4 (TME) is a complex tissue where cancer cells continuously 77 
interact and dynamically co-evolve with the other cellular (immune, stromal, and endothelial 78 
cells) and non-cellular (the extracellular matrix, ECM) components. The dynamic nature of 79 
this complex landscape dictates whether immune cells play as friends or foes of malignant 80 
cells, thus strongly affecting both disease progression and response to therapy. Nowadays, 81 
great efforts from onco-immunologists, bioinformaticians, and systems biology experts are 82 
converging to address the clinical significance of cancer heterogeneity5,6, either in the space 83 
(i.e., in distinct tumoral regions) and time (i.e., at distinct tumor progression stages)5,6, and to 84 
characterize cancer and immune cell phenotype and function at a single-cell level. As an 85 
example of this synergy, advanced computer-vision techniques are now routinely used for 86 
spatial mapping of immune infiltrate in histological samples7,8. 87 
 88 
On the front of experimental models, bridging animal studies and traditional in vitro methods, 89 
advances in microfluidics and co-culturing techniques give access to different classes of micro-90 
engineered cellular models such as organoids, micro-physiological systems9,10,11 (MPS), and 91 
organs-on-chip12–14 (OOC). They share the common trait to zoom in the ‘big picture’ view of 92 
the cellular ecosystems and expanding the in vitro potential to control microenvironmental 93 
factors while exploiting high-content microscopy15 and image processing approaches.  94 



   

 

 95 
Nowadays, state-of-the-art- MPS and OOC systems have begun to include immunological 96 
aspects , incorporating different subtypes of immune cells in existing tissues- and co-cultures, 97 
so to explore and measure a variety of processes like inflammatory diseases, wound healing, 98 
mucosal immunity, and response to toxins or daily food products16. TME-on-a-chip models10-99 
17, also integrated with perfusable microvessels18–21, have been developed to investigate cell-100 
type-dependent interactions, physical and chemical perturbations, and the cytotoxic activity 101 
of infiltrating lymphocytes22, as well as clinically relevant immunomodulatory agents23. 102 
 103 
Here, we provide versatile protocols, spanning from loading cells in chips to image processing 104 
tools, to exploit advanced tumor-immune microfluidic co-cultures in 2D (section 1) and 3D 105 
(section 2) settings16, compatible with dynamic, multiparametric24 monitoring and 106 
visualization of cellular functions. This is achieved maintaining easiness of use and flexibility 107 
both in sample management and data analysis, taking advantage of Fiji freeware software 108 
and its toolboxes25,26. 109 
 110 
The microfluidic device, described in section 1, is designed to perform 2D co-cultures of 111 
adherent cancer and floating immune cells. This platform was validated for the in vitro 112 
measurement of immune cell behavior in the presence of genetic mutations27 and/or 113 
immunodeficiencies28. Here, we illustrate steps for tracking immune cells in time-lapse bright-114 
field images, by exploiting a semi-automatic method based on Trackmate (a plugin 115 
implemented in Fiji software). This procedure enables the extraction of kinematic descriptors 116 
of immune migration 29 and response (i.e., interaction times) to target cancer cells, treated or 117 
not with immunogenic cell death inducers27. 118 
 119 
Importantly these parameters, extracted from time-series images, can be processed with 120 
advanced mathematical machinery. As an example of the potentiality of this approach, our 121 
groups recently published an analysis based on mathematical methods from stochastic 122 
processes and statistical mechanics to model cellular network properties and provide a 123 
parametrized description of immune cell behavior (i.e., biased or uncorrelated random walk, 124 
highly or not coordinated motion30,31). 125 
 126 
The 3D setting, provided in the second section, is based on a co-culture protocol to recreate 127 
more complex immunocompetent TMEs embedded in two gel regions with different 128 
combinations of cell types and drugs in a competitive fashion. Here, image processing steps 129 
are described to measure, at different timepoints, the infiltration of stained immune cells in 130 
human A375M melanoma cells cultivated within Matrigel, to evaluate antitumor agent 131 
combinations32. A375M line, an A375P derived cell line characterized by a highly metastatic 132 
phenotype was chosen to evaluate their metastatic capability in the presence of immune 133 
cells32.  134 
 135 
The described models can be fully compliant with different cell sources (murine and human 136 
immortalized or primary cell lines, organoids, xenografts, among the others). In recent studies 137 
of our lab, by combining high-content video microscopy with image analysis, the competitive 138 
3D layout was applied to investigate: i) an anti-tumoral (antibody-dependent cell-mediated 139 
cytotoxicity, ADCC) immune response and dissect the role of fibroblasts in resistance to 140 
trastuzumab therapy in HER2+ breast cancer on-chip models33; ii) the action of myeloid cells 141 



   

 

(i.e., cancer-associated macrophages) in mechanisms of tumor evasion and recruitment of T 142 
cells34; iii) the efficacy of immunotherapeutic regimes, specifically based on Interferon-α-143 
conditioned dendritic cells (IFN-DCs), cultivated with drug-treated colon cancer cells in 144 
collagen matrices, and to evaluate efficient motion and the succeeding phagocytosis events35; 145 
iv) the chemotactic migration of bone marrow-derived eosinophils towards IL-33 treated or 146 
untreated melanoma cells36. 147 
 148 
These advanced models could serve as observation windows for understanding the role of 149 
immune contexture in cancer metastasis and resistance mechanisms, but efforts are required 150 
to translate findings into the clinics, closing the gap with basic research37. 151 
 152 
As an emerging scenario, harnessing the power of automated high-content microscopy 153 
coupled to the use of more physiologically-relevant microsystems is opening novel potential 154 
challenges for the handling, processing, and interpretation of hundreds, and even thousands, 155 
of Gigabytes of multiparametric data, which can be generated from a single experimental 156 
campaign. This implies a direct link of OOC experiments with artificial intelligence38,39, 40,41,42 157 
(AI)-based algorithms both for advanced automated analysis, and generation of features 158 
which can feed in turn in silico models of cancer-immune interplay43, with exciting new 159 
applications at the horizon, such as the development of predictive drug screening assays44. 160 
 161 
An ever-expanding flow of efforts is focused on the design of disease models jointly with the 162 
optimization of strategies to implement the large-scale perturbation screens with single-cell 163 
multi-omics readouts. This will undoubtedly help the development and, hopefully, the clinical 164 
implementation, accompanied by an appropriate degree of method standardization, of a 165 
systematic onco-immunology-on-a-chip approach to gain novel insights into immune 166 
disorders and cancer dissemination mechanisms. 167 
 168 
PROTOCOLS  169 
 170 
1. Chip design for adherent and floating cells 2D co-cultures 171 
 172 
NOTE: The 2D co-culture layout (Figure 1A-C) is characterized by three chambers (100 µm 173 
high) interconnected by two sets of microchannel arrays (500 x 12 x 10 µm3, L×W×H). The 174 
intermediate chamber forms two closed dead-end compartments which block floating 175 
immune cells overflowing into the tumor site during the loading step 1.2.5. This device type 176 
is useful for real-time bidimensional measurements of single-cell (either adherent or floating) 177 
motility, and of cell-cell interactions16,27,28,30,31. A typical cell migration study (conducted from 178 
several hours to several days) combines live-cell microscopy with image-processing 179 
algorithms45, in order to translate the acquired image sequences into numerical features25. 180 
Based on the migratory patterns, several biophysical indicators can be estimated, such as the 181 
displacement and velocity of cells, as well as the duration of immune cell and target cell 182 
interactions24,46. 183 
 184 
1.1. Preparation of cancer and PBMC cells  185 
 186 
1.1.1. Cancer cell culture 187 
 188 



   

 

NOTE: MDA-MB-231 triple-negative [estrogen receptor (ER)-, progesterone receptor (PR)-, 189 
and human epidermal growth factor receptor 2 (HER2)-] human breast adenocarcinoma cells 190 
are routinely grown in a Roswell Park Memorial Institute (RPMI) 1640 medium supplemented 191 
with 10% (v/v) fetal bovine serum (FBS), 2 mM L-glutamine, 100 IU mL−1 penicillin G sodium 192 
salt and 100 µg mL−1 streptomycin sulfate (growth medium), under standard culture 193 
conditions (37 °C and 5% CO2). 194 
 195 
1.1.1.1. To optimize cell culture growth, plate MDA-MB-231 cells in 75 cm2 flasks at a 196 
density of 1 × 106 cells mL-1 in 12-to-15 mL of growth medium. 197 
 198 
1.1.1.2. When cells reach the 75-80% of confluence, discard the growth medium, wash 199 
cells with pre-warmed phosphate-buffered saline (PBS) to completely remove FBS, and then 200 
detach them with pre-warmed trypsin (1-to-2 min at 37 °C). 201 
 202 
1.1.1.3. Add growth medium to inactivate trypsin enzymatic activity and collect 203 
detached cells. Wash cells twice for 5 min at 1,100 x g at room temperature (RT). 204 
 205 
1.1.1.4. Count cells in a cell counting slide by means of Trypan Blue dye exclusion test 206 
and then reseed them either for maintenance culture (for no more than 6 passages from 207 
thawing) or for experimental procedures. 208 
 209 
1.1.1.5. For microfluidic experiments, seed 1 × 106 cells in 6-well plates in 3 mL of 210 
growth medium and either treat with 25 µM doxorubicin (DOXO) or an equal volume of DOXO 211 
solvent (PBS) as control. 212 
 213 
1.1.1.6. Four-to-6 hours after, wash DOXO-treated cells twice with pre-warmed PBS for 214 
5 min at 1,100 x g at RT. 215 
 216 
1.1.1.7. Count DOXO-treated and PBS-treated control cells as above (see step 1.1.1.5) 217 
and set the co-culture with peripheral blood mononuclear cells (PBMCs) in microfluidic 218 
devices. 219 
 220 
1.1.2. PBMC isolation 221 
 222 
1.2.1 Collect venous whole blood (10 mL approximately) from healthy volunteers in 223 
heparinized vials and gently mix by inverting the tube 2-to-4 times47. 224 
 225 
1.2.2 Dilute blood 1:1 with PBS and layer over 10 mL of density gradient medium 226 
Lymphoprep in a 50 mL tube.  227 
 228 
NOTE: Ensure to do the layering very gently and slowly to let blood and Lymphoprep form 229 
two distinct layers. 230 
 231 
1.2.3 Centrifuge tubes for 30 minutes at 400 x g at 4 °C in a swing-out bucket without brakes. 232 
Four distinct layers will form: (i) plasma at the top, (ii) a white and cloudy layer containing 233 
PBMCs, (iii) Lymphoprep, and (iv) a pellet of erythrocytes and granulocytes.  234 
 235 



   

 

1.2.4 Aspirate gently PBMCs with a 2 mL pipette and immediately resuspend in warm 236 
growth medium (same used in step 1.1.1) and wash twice for 5 min at 1,100 x g at RT. 237 
 238 
1.2.5 Count pelleted PBMCs as above (see step 1.1.1.5) and either use for experimental 239 
procedures or freeze for long-term storage. 240 
 241 
1.2. Plating the cells in 2D chips 242 
 243 
NOTE: PBMCs are not stained in this protocol. To characterize specific phenotypes on-chip, 244 
immune cell sub-populations can be isolated by immunomagnetic bead selection, stained 245 
with fluorescent cell trackers, re-mixed with the unlabeled remaining fraction, and thus 246 
confronted with target cancer cells, as reported in the on-chip experiments, described in 247 
Vacchelli et al.27, and in Racioppi et al.34.  248 
 249 
1.2.1. Before starting co-culture experiments and to facilitate the addition of reagents, 250 
activate stored chips by an oxygen plasma treatment for a few seconds. Immediately fill 251 
reservoirs with deionized water or PBS to keep PDMS (polydimethylsiloxane) surfaces 252 
hydrophilic until plating steps.  253 
 254 
NOTE: PDMS is intrinsically hydrophobic, which may result in difficulties in operating and in 255 
the entrapment of air bubbles in microchannels. See step 7 in the supplementary file 256 
providing details about oxygen plasma activation. 257 
 258 
1.2.2. Sterilize under a UV cabinet for 20 min, wash 2-3 times with fresh PBS, and then 259 
incubate with culture media for 1 h. Keep chips in incubator until performing plating steps. 260 
 261 
1.2.3. Withdraw excess media from all six reservoirs. Take care to avoid sucking up media 262 
from the main culture chambers. 263 
 264 
1.2.4. Slowly apply 1 × 105 cells resuspended in 10-20 µL of growth medium in the upper 265 
left-hand reservoir, and then in the lower well (Figure 1A, reservoirs 1 and 2). Wait 5 min to 266 
let cells adhere into the tumor chamber. Some cells will settle and attach in the reservoirs.  267 
 268 
NOTE: Insert cellular suspension next to the channel openings. This procedure is applied to 269 
MDA-MB-231 cancer cells, other lines will require cell density optimization. To improve 270 
cancer cell attachment, a coating functionalization of surfaces (e.g., poly-L-lysine, 271 
fibronectin) can be performed. Please, refer to previously published protocols for coating 272 
steps16, 48–50. 273 
 274 
1.2.5. On the right side gently pipet 1 × 106 PBMC resuspended in 50 μL of growth medium 275 
into wells 3 and 4 (see Figure 1A, reservoirs 3 and 4).  276 
 277 
NOTE: After flowing, PBMC will distribute into the intermediate chamber creating a “front”, 278 
which represents the starting point of the experiment.  279 
 280 
1.2.6. Fill all the six reservoirs with up to 100-150 μL of growth medium. Under a 281 
microscope check that cells have distributed correctly in the culture compartments as 282 



   

 

depicted in Figure 1D-E. Final volumes can vary with the size of the reservoirs. Adjust 283 
volumes to be equal in all wells.  284 
 285 
1.2.7. Place the chips back in the incubator for approximately 1 h to stabilize the system 286 
prior to time-lapse recording. Add fresh medium every 3 days, as it may be subjected to 287 
evaporation losses.  288 
 289 
NOTE: The system is compatible with both live/dead-cell analysis and dynamic multiplex 290 
cytokine secretion profiling from conditioned media. For chemokine analyses, up to 200-250 291 
µL aliquots of supernatants may be accessible by collecting media from the two reservoirs of 292 
each compartment. Classical ELISA and Luminex cytokine profiling assays require about 50 293 
µL of supernatants. Please see 51, 52 examples of studies of other labs performing cytokine 294 
profiling on OOC models.  295 
 296 
1.3. Time-lapse acquisition of unlabeled cancer and immune cells  297 
 298 
NOTE: Typically, 3 chips are arranged on a single microscope slide (see Figure 1A for 2D chip 299 
and Figure 4A for 3D chip). Using stage holders allocating 4 slides, co-cultures can be suitable 300 
to be monitored by automated high-content microscopy to analyze large batches of 301 
experimental conditions. Chips can be easily mounted on slides with thickness equal to 1 mm 302 
or 170 microns (plastic or glass coverslips, 6-well optical bottom multi-wells) for high-303 
resolution confocal imaging. 304 
 305 
1.3.1. Record bright-field image series of unlabelled cells by means of a video microscopy 306 
setup equipped with an incubation system.  307 
 308 
NOTE: Here time-series datasets (time window: 48 h, frame rate: 2 min) were acquired with 309 
a fluorescence microscope, equipped with a 4x objective and CMOS 1.3M pixels, optimized 310 
to fit into a standard cell culture incubator.  311 
 312 
1.3.2. Warm up the microscope for at least 2 h to equilibrate to 37 °C and 5% CO2 before 313 
starting acquisition.  314 
 315 
1.3.3. Select the window of observation by centering the microchannel array between the 316 
tumor and the central compartment. This allows to visualize the dynamics of immune 317 
infiltration and the interactions within the region in which cancer cells are seeded. 318 
 319 
1.3.4. Adjust the illumination intensity and focus of cancer and immune cells.  320 
 321 
1.3.5. For launching time-lapse acquisition, optimize frame rate and time duration 322 
according to experiment and cell type under study.  323 
 324 
NOTE: Imaging conditions must be optimized to avoid excessive photo-exposure while 325 
maintaining a good signal-to-noise ratio (SNR). As immune cells are very motile, the 326 
acquisition frame rate needs to be sufficiently high to follow the dynamic process of interest 327 
and enable easy tracking53. A compromise should be reached between the tracking 328 
algorithm, the compatibility with the size of the resulting dataset, and the viability, density, 329 



   

 

and motility of observed cells.  330 
 331 
1.3.6. At the end of the time-lapse, use the function Import Image Sequence and Save as 332 
of the ImageJ software to convert the frame dataset in a 25 fps uncompressed video file.  333 
 334 
NOTE: The generated video file is now ready for cell tracking analysis. Here, RGB (1280x1024 335 
pixels) images were collected with a spatial resolution of 1.33 μm/pixel. A 24 h duration 336 
movie (3.5 GB stack) of a single field of view (FOV) consists of 720 frames for each condition.  337 
 338 
1.4. Data analysis: Semi-automatic extraction of unlabeled immune tracks by Trackmate  339 
 340 
NOTE: Here, immune motility analysis in 2D unlabeled time-lapse images is carried on using 341 
TrackMate54, an open-source toolbox available in the Fiji/ImageJ software bundle 342 
(https://imagej.nih.gov/ij/). Several algorithms are provided to perform automated single-343 
particle tracking55 (SPT) of spot-like structures. They have been applied efficiently to 344 
fluorescent images, where objects are bright over a dark background with high SNR (i.e., sub-345 
resolution fluorescent spots, labeled traffic vesicles, nuclei)1, 25, 56–58. SPT is mainly based on 346 
two sequential steps. First, objects are localized with identified positions in multiple frames 347 
(segmentation), as schematized in Figure 2. In the second stage (particle linking), detected 348 
spots are linked over consecutive frames to estimate motion and reconstruct their 349 
trajectories, in the shape of a track (Figure 3). Numerical features can be computed from each 350 
extracted X, Y, Z coordinates array over time. Extended documentation is reported in 54 as 351 
well as online (https://imagej.net/TrackMate), following the Getting started with TrackMate 352 
tutorial. The accuracy of the process can be inspected immediately, handling an intuitive 353 
graphical user interface (wizard-like GUI) that enables users, at every step, to readjust 354 
settings. The following part briefly depicts how to use Trackmate for image processing and 355 
quantification steps, applied to visible light images: 356 
 357 
1.4.1. Drag and drop the full-time video/image stack on the Fiji toolbar. 358 
 359 
1.4.2. Calibration stack setup (Figure 2A).  360 
 361 
1.4.2.1. Check the dimensionality and assign the image properties by selecting 362 
Image> Properties. Fill Unit of length, Pixel dimensions and Frame interval boxes.  363 
 364 
1.4.2.2. To perform the calibration, use the known length of the microchannels (500 365 
μm, Figure 1C) and divide by the corresponding measured length in pixels. For 2D time-366 
series, make sure to swap Z/T field entering 1 as z-slice and the correct number of movie 367 
frames. If not accomplished, Trackmate quantitative outputs and parameters will be 368 
reported in pixel units and timeframes.  369 
 370 
1.4.3. Pre-processing of images 371 
 372 
1.4.3.1. To enhance the correct discrimination of immune cells from a noisy 373 
background, pre-process bright-field images to compensate artifacts. Ensure that datasets 374 
consist of 8-bit TIFF images (brightness range: 0–255).  375 
 376 



   

 

NOTE: Uneven illumination, low SNR, and contamination by small debris particle in visible 377 
light images could compromise the success of a cell tracking process. Here, time-series 378 
datasets are pre-processed through background subtraction, brightness/contrast adjust 379 
function, and by local image subtraction of a Gaussian blur from original images. There are 380 
other different analysis toolkits available in ImageJ for processing and segmentation of 381 
phase-contrast or bright-field images, including Empirical Gradient Threshold (EGT)59. 382 
 383 
1.4.4. First calibration panel (Figure 2A) 384 
 385 
1.4.4.1. Revise/confirm the dimensionality and temporal window of data (i.e., pixel-386 
width and frame interval).  387 
 388 
NOTE: TrackMate automatically reads in the image properties box to give the final tracking 389 
results in calibrated physical units (i.e., µm and minutes).  390 
 391 
1.4.4.2. Define a region of interest to compute the extraction of immune tracks, by 392 
manually inserting values or by drawing a closed area over the active image and then press 393 
the Refresh source button. To extract global immune migration paths, select rectangular 394 
regions respectively on the right side of microchannels (central chamber, Figure 1F) and on 395 
the left (tumor chamber, Figure 1E).  396 
 397 
1.4.4.3. To analyze interactions between cancer and immune hotspots, draw circular 398 
sub-regions by using ROI tools (go to Edit → Selection → Specify).  399 
 400 
NOTE: When running for the first time this toolbox on a new biological application, spend 401 
the necessary time to optimize settings for reconstructing the tracks.  402 
 403 
1.4.4.4. Perform manual tracking of the cell trajectories (about 50-100 cells) to find 404 
empirically the right configuration and next to validate as a benchmark the reliability of 405 
automatic extraction of movements. Additionally, work initially on a smaller area to easily 406 
check the accuracy of the chosen parameters. 407 
 408 
1.4.5. Immune spots detection step (Figure 2B) 409 
 410 
1.4.5.1. Select the default Laplacian of Gaussian (LoG) detector. The LoG detector 411 
works to find bright, blob-like, roundish objects and applying a Laplacian of Gaussian filter 412 
on the image tuned for intermediate spot sizes (5-to-20 pixels in diameter).  413 
 414 
1.4.5.2. In Estimated Blob Diameter (here, 10–13 μm) enter a value slightly bigger 415 
than the expected spot size. Increase Threshold (here 1-3 µm) value until extra spurious 416 
background spots are reduced possibly without removing the object features. Detections 417 
below Threshold value (based on a quality metrics) will be discarded from subsequent 418 
analysis. Check the box for the median filter and sub-pixel localization to improve the quality 419 
of spot detection.  420 
 421 
1.4.5.3. Use the Preview button to view and quickly inspect identified immune cells 422 
overlaid on the images by magenta-colored circles. Mistakes during the detection will have a 423 



   

 

considerable impact on the linking process. Other unwanted detections can be corrected in 424 
the subsequent menus by user-defined filters (i.e., by spot intensity, size, or position). 425 
 426 
1.4.6. Once satisfied with selections, hit Next. These settings may vary depending on 427 
experimental and acquisition imaging modalities (e.g., FOV, objective magnification, bright-428 
field or fluorescent images) setup, cell type (adherent or floating cells), from slow or fast 429 
motility, kind of cellular behavior (interacting or not) and low/medium/high density in the 430 
observation area. 431 
 432 
1.4.7. Proceed and skip Initial Thresholding menu. Select the Hyperstack Displayer 433 
window. 434 
 435 
1.4.8. Filter on spots’’ panel (Figure 2C). 436 
 437 
1.4.8.1. Select: Uniform Color. Filters, as shown in Figure 2C, can be added to retain 438 
labeled spots with feature values, displayed in a histogram, above or below a reversible 439 
threshold.  440 
 441 
1.4.8.2. Tracker selection stage (Figure 3A). Choose the Simple LAP tracker, as 442 
particle linking algorithm asking for three fields to fill (in this case, “Linking max distance”: 443 
30-50 µm, “Gap-closing max distance”: 25-50 µm, “Gap-closing max frame gap”: 4-6). This 444 
detector manages gap-closing events, with cost linking calculation solely based on their 445 
respective distance. 446 
 447 
NOTE: The maximal allowed linking distance limits the spatial search range for candidate 448 
matching spots, corresponding to the maximally allowed displacement traveled by between 449 
two subsequent frames (Figure 3D).  450 
 451 
1.4.8.3. Provide larger values of maximal displacement when the fragmentation of 452 
tracks of highly motile particles is noticed. Two-track links will not be connected if the 453 
frame-to-frame movement is larger than the given maximal distance value. If segments 454 
bridge badly two different cells, decrease the value of maximal displacement.  455 
 456 
1.4.8.4. Try to reconnect missing spots, varying the values of “the max distance for 457 
gap closing” and “the maximal frame gap”. These parameters deal with gap-closing events 458 
in non-adjacent frames. Spot disappearance may occur for some frames (i.e., out of focus 459 
particles, cells leaving out and in the FOV, segmentation failures in a noisy image).  460 
 461 
NOTE: To handle splitting or merging events, opt for LAP linker as detector which introduces 462 
linking cost matrix penalties. 463 
 464 
1.4.9. Click Next to run the tracking computation. Press Next. 465 
 466 
1.4.10. Filtering tracks panel (Figure 3B). Change the color of immune paths selecting, from 467 
the drop-down menu, “Track ID” or other track features. At this point, choose optionally to 468 
set interactive filters functional, to improve the quality of the outcome and revisit the 469 
procedure.  470 



   

 

 471 
NOTE: Spurious spots arise from noise in the image and loss of feature quality. This will 472 
generate short segments while cells of interest can be tracked over many frames.  473 
 474 
1.4.11. As a strategy try to filter out, based on the number of spots they contain. 475 
Additionally, sort tracks using a combination of options such as Track displacement, Track 476 
duration or Minimal/Mean/Maximal Velocity to exclude false or unwanted tracks (with 477 
fewer frames respect to overall duration of time-lapse or involving dirty or not moving 478 
particles) from further post-processing.  479 
 480 
NOTE: The choice of filters can vary depending on the specific application and biological 481 
system. 482 
 483 
1.4.12. Examine all tracks in the Display Options interface, scroll through time, and verify 484 
how accurate tracks match cell migration paths. The drop-down menu provides color codes 485 
for spots and paths for easy visualization and filtering by several modalities (e.g., kinetic 486 
parameters, intensity, temporal or spatial position).  487 
 488 
NOTE: For tracking high-density cultures, or high-motile cells, increase the acquisition frame 489 
rate minimizing cell displacement traveled in consecutive time intervals. 490 
 491 
1.4.13. Manual correction of segmentation and linking mistakes (Figure 3E).  492 
 493 
1.4.13.1. To enhance further the quality of results, edit manually spots (debris 494 
particles, stationary cells) and remove erroneous tracks deriving from detected tumor 495 
boundaries when analyzing tumor-immune interaction ROIs.  496 
 497 
1.4.13.2. First, select the TrackMate tool in the ImageJ toolbar. For eliminating an 498 
existing spot throughout the whole stack, press shift and create by mouse cursor a ROI mask 499 
over the target spot (edited in a green circle), and then hit the DEL key.  500 
 501 
1.4.13.3. For adding a new spot (in case of missing tracks due to spots disappearance) 502 
press the A key, laying the mouse at the pointed location. Repeat the tracks-linking 503 
computation process after this step. 504 
 505 
1.4.14. When satisfied, select Analysis in the Display Options panel to generate three text 506 
files (Figure 3C). The table in “Spots in tracks statistics” provides the spatiotemporal 507 
coordinates of immune spots (X-Y-Z positions of the cells labeled with the associated frame 508 
and track number). “Links in tracks statistics” and “Track statistics” contain information 509 
relative to the tracks: track durations, number of detected gaps or spots, track initial and 510 
stop-frame, etc. Save and export for each dataset.  511 
 512 
NOTE: When clicking on a row within the result windows, the respective spot, link, or track 513 
is activated within the time-lapse video for visual inspection. Repeat the filtering steps to 514 
select/remove tracks. All future exported data will be updated. TIP: Track initial and stop-515 
frame and track duration values can be exploited to calculate times of contact between 516 
cancer and immune cells when processing ROIs of interaction. 517 



   

 

 518 
1.4.15. Press the Save button to generate a resulting XML file containing all the parameter 519 
values, the path to images, and spot positions in time. The ‘’Load TrackMate file’’ command 520 
restores the whole process session for each movie file individually. 521 
 522 
1.4.16. Move to the last panel of the GUI called Select an action. In the list, use Capture 523 
overlay > Execute function to produce a video with tracks overlaid. TIP: “N-spots vs time” 524 
option may be used to compute the spatial density of immune cells in a ROI (Figure 6B, right 525 
panel). 526 
 527 
1.4.17. Post-processing analysis and migration statistics 528 
 529 
1.4.17.1. Analyze the raw positional data directly in Trackmate or export data to 530 
calculate comprehensive kinetic parameters29 (i.e., total trajectory length, Euclidean 531 
distance, confinement ratio, mean-squared displacement56, average or instantaneous track 532 
velocity, arrest coefficient, distribution of angles of migration, Forward migration index, 533 
mean straight-line speed) to classify immune cell migration behavior (e.g., directed or 534 
diffusive motion30, 31) and response to target cancer cells (e.g., treated vs control).  535 
 536 
NOTE: Additional useful plugins such as The Chemotaxis and Migration Tool 537 
(http://ibidi.com/software/chemotaxis_and_migration_tool/) provides various graphs (e.g., 538 
Rose or sector plots, such as depicted in Figure 6) and statistical tests for advanced analysis 539 
and visualization of experimental migration and chemotaxis data. Combining cell tracking 540 
and cell segmentation algorithms24, 25, 45 may enable measurements of morphological 541 
metrics at the single-cell level (i.e., cell surface area, the major and minor axis length, and 542 
the cell aspect ratio). 543 
 544 
2. 3D immuno-competent cancer on-chip model in a competitive assay 545 
 546 
NOTE: The 3D chip design, depicted in Figure 4, consists of 5 major compartments: a central 547 
one for the floating immune cells intake, two side regions for embedding tumor cells in 548 
hydrogel matrices (150-250 μm high), and media perfusion chambers. Immune and tumor 549 
chambers are connected by two sets of narrow arrays of microchannels (200×12×10 μm3, 550 
L×W×H, Figure 4E). Regularly 100 µm-spaced trapezoidal isosceles micropillars (about 25-30 551 
interfaces for each side gel region, Figure 4C) work as barriers to confine gel solution during 552 
injection exploiting the balance between surface tension and capillary forces60, 61 and connect 553 
tumor regions to the two lateral additional media chambers in order to set a gel-liquid 554 
interface (Figure 5). The detailed features of the 3D competitive assay are shown in Figure 4. 555 
Preferential migration of immune cells towards the two hydrogel compartments hosting 556 
tumoral cells that have undergone different treatments can be monitored and quantified. The 557 
particular competitive layout can be applied to investigate a plethora of different cancer 558 
biology phenotypes (e.g., drug-resistant vs aggressive, primary or metastatic, responders vs 559 
non-responders). Additionally, the gel embedded regions can be easily integrated with 560 
different cell populations to recreate more heterogenous TMEs, including stromal 561 
components (fibroblasts, endothelial cells)23 or to simulate specific immunosuppressive 562 
milieu34 (e.g., macrophages) for dissecting mechanisms of drug resistance and tumor evasion.  563 
 564 



   

 

NOTE: Nuclear and active caspase staining, by using commercial kits for Live/dead assays (e.g., 565 
Thermo Fisher Scientific, Incucyte reagents), can be implemented to assess mitotic or 566 
apoptotic death events, as reported in Nguyen et al.33. 567 
 568 
2.1. Preparation of matrix solution with cells and Loading in the device  569 
 570 
NOTE: In the following experimental setting, the two gel regions contain mixtures of human 571 
A375M melanoma cell lines, grown in matrix solution (e.g., Matrigel), exposed to therapeutic 572 
agents used as monotherapy or in combination. This setting allowed us to evaluate the 573 
efficacy of a combination of two drugs with respect to single ones in a competitive fashion 574 
and to quantify their ability to attract PBMCs. 575 
 576 
2.1.1. Defrost a stock of matrix solution (e.g., Matrigel) by placing on ice into a 4 °C 577 
refrigerator one day before the experiment.  578 
 579 
NOTE: Do not expose the product to multiple freeze-thaw cycles as it becomes “clumpy”. 580 
Other synthetic or natural hydrogels protocols can be suitable to be used in this setting. Please 581 
refer to 33–35 for the preparation of cancer cells in collagen matrices. 582 
 583 
2.1.2. Resuspend A375 human melanoma cells, stained with live-compatible PKH67 Green 584 
Fluorescent Cell Linker in matrix solution (2 mg mL-1). Where indicated, add 5-aza-2'-585 
deoxycytidine (DAC; 2.5 μM), referred as DAC, and/or IFN-α2b ,referred as IFN, at the proper 586 
doses32.  587 
 588 
NOTE: Match the Lot # on the bottle spec sheet. Based on the concentration calculate the 589 
volume of medium needed to make up to 2 mg mL-1 Please adjust the optimal protein 590 
concentration and cancer cell suspension concentration accordingly to your application of 591 
interest. 592 
 593 
2.1.3. Pipette up and down carefully to avoid the generation of bubbles. Keep the 594 
microcentrifuge tube on ice while mixing to prevent any unwanted polymerization. 595 
 596 
2.1.4. After sterilization, place the devices on ice (using an ice bucket and lid) to avoid matrix 597 
solution solidification during the whole procedure of cell loading. 598 
 599 
2.1.5. Slowly inject the two IFN and DAC/IFN Matrigel/tumor cell mixtures (2-4 µL) into the 600 
left and right gel port, respectively with 10-μL micropipette using cold tips (Figure 5A). Apply 601 
gentle pressure to push matrix solution from one side until reaches the opposite one.  602 
 603 
NOTE: The volume of matrix solution was chosen to avoid overflowing into adjacent channels. 604 
Do not exert excessive pipetting pressure to prevent the solution from leaking into the media 605 
and central channels. If during loading gel path is blocked along the channel, try to insert the 606 
solution from the other inlet until the gel fronts meet. When removing the micropipette from 607 
the inlets, hold the plunger, otherwise the negative pressure will aspirate matrix solution. 608 
 609 
2.1.6. Place the device in an incubator in upright position at 37 °C and 5% CO2 for 30 minutes 610 
to allow gelation of the matrix solution to take place (Figure 5B). Handle with care chips with 611 



   

 

embedded unpolymerized gel to prevent leaking out of the gel channel. 612 
 613 
2.1.7.  In the meantime, resuspend PKH67-labelled PBMCs (1x106 cells) in 10 µL of complete 614 
DMEM (Dulbecco's modified Eagle's medium). 615 
 616 
2.1.8.  After matrix gelation, fill media channels with (50-100 µL) the same aliquot of culture 617 
medium in all six reservoirs to prevent gel drying in the chips. Keep in incubator until immune 618 
cell suspension seeding.  619 
 620 
NOTE: Check under a microscope the correct and homogeneous distribution of tumor cells in 621 
the gel and the integrity of the polymerized gel barriers. Partially or not uniform gelled regions 622 
or bubbles in the mixture lead to the premature flowing of PBMCs in gel media channels at 623 
the starting point of the experiment due to pressure initial fluctuations. 624 
 625 
2.1.9. Aspirate media from the six wells and position the tip near the inlet of a media channel 626 
to inject gently with moderate pressure PBMC cell suspension. The loading temporal 627 
sequence is depicted in Figure 5C: 628 
1. PBMCs in 10 μL medium into the upper central well. 629 
2. 50-100 μL medium into each of four wells of lateral channels. 630 
3. 40-90 μL medium into the upper central well. 631 
4. 50-100 μL medium into the lower central well. 632 
 633 
2.1.10. Ensure under a microscope that the PBMCs distribution remains confined in the 634 
central chamber after the loading step. (Figure 7A).  635 
 636 
NOTE: If it is not optimal, adjust the concentration if needed and repeat the seeding steps, 637 
using pristine chips. When calculating volumes for the planned experimental conditions, refer 638 
to an excess number of chips (15-20%) to take in account of potential errors and adjustments. 639 
Volumes and concentrations should be optimized according to the specific application. 640 
 641 
2.1.11. Place assembled devices on a level surface in the incubator at 37 °C and 5% CO2 for 642 
subsequent fluorescence imaging acquisition. Handle with care chips after loading immune 643 
cells which are floating.  644 
 645 
NOTE: Compensate evaporative losses of volumes in reservoirs by replacing media every 2-3 646 
days. For chemokine profiling, up to 100 µL from each of two wells of culture compartments 647 
can be aspirated, please refer to step 1.2.7, in step 1. 648 
 649 
2.2. Automated Counting of recruited PBMCs in single-channel fluorescent images in 650 
ImageJ 651 
 652 
NOTE: Classical methods of immunofluorescence for confocal high-resolution imaging can be 653 
applied to on-chip operations as endpoint measurements. The basic staining procedure 654 
involves cell on-chip fixation, permeabilization, blocking, antibody binding, staining of nuclei 655 
with washing steps in between. Unlabeled immune cells infiltrated in 3D gels regions with 656 
embedded cancer microenvironments can be fixed at desired time-points and stained for 657 
expression markers of activation/exhaustion /maturation (e.g., for CD8 cells, monitoring of 658 



   

 

CD69, CD95, PD1, TIM3 markers). In Parlato et al.35, phagocytosis of SW620 apoptotic cells 659 
was evaluated by confocal microscopy, using devices mounted on 170 µm-thick coverslips. 660 
IFN-DCs were stained adding on-chip anti-human HLA-DR-FITC Ab aliquots. 661 
 662 
To calculate the extent of infiltrated fluorescently stained live immune cells challenged with 663 
competitive signals, a common image analysis workflow is set as follows (Figure 7 D-G): 664 
 665 
2.2.1. Acquire, at specific time endpoints, phase contrast, and red/green channels 666 
fluorescence microphotographs of the left and right gel regions containing tumor cells 667 
respectively exposed to single or combinations of pharmacological regimes.  668 
 669 
NOTE: Here images were captured by an EVOS-FL fluorescence microscope after cell loading 670 
(0 h), after 48 h and after 72 h of incubation (Figure 7A-B). A 4x-10x magnification was used 671 
to acquire the central chamber, the microchannel arrays, and the two juxtaposed side 672 
channels containing A375 plus IFN and A375 plus DAC/IFN.  673 
 674 
2.2.1.1. When performing acquisition operations,  consider the parameters to measure 675 
and avoid saturation of features to be counted. Optimal segmentation results depend on the 676 
nature of the acquired images, due to variability in the biological samples themselves, quality 677 
of staining, and the microscopy techniques utilized for user-oriented applications. 678 
 679 
2.2.2. Load fluorescence single-channel data (in this case red = PBMCs), in Fiji by dragging it 680 
into the main window (Figure 7D). Duplicate the image to avoid overwriting the raw data 681 
during the selection of pre-processing filters until final segmentation.  682 
 683 
2.2.2.1. If the image is a color image (RGB), hit Image > Type 8 or 16-bit to convert to 684 
greyscale. Check that Edit Options Conversions is set to scale when converting. 685 
 686 
2.2.3. Preprocessing raw data via cleaning-up of noise and artifacts.  687 
 688 
2.2.3.1. Go to Process > Subtract Background menu by applying the rolling ball 689 
algorithm to correct uneven noise background with large spatial variations of intensities. Set 690 
the radius to at least the size of the largest foreground particle.  691 
 692 
2.2.3.2. Pick the Preview box for trial and error procedure to yield optimal results. Too 693 
small values may incorrectly remove structures of interest. In Brightness&Contrast command 694 
drag Minimum/Maximum sliders to change the range of intensities in the histogram. Shift 695 
the Maximum slider to the left to increase the brightness, without wash-out features. Move 696 
the Minimum slide to the right to increase the contrast of the image avoiding disappearance 697 
of less visible features in the background. Click Apply to fix changes. 698 
 699 
2.2.4. Image Enhancement.  700 
 701 
2.2.4.1. Go to Process > Filters and experiment with the Median, Gaussian filters on 702 
images (Figure 7E).  703 
 704 
NOTE: Pre-filtering radius should be adapted to the image noise pixels. The non-linear Median 705 



   

 

filter replaces pixel value with the median value of neighbours, to reduce salt-and-pepper 706 
noise. “Gaussian Blur” is used to smooth a digital picture, by replacing pixels with a weighted 707 
average of surrounding pixels. The weights come from the Gaussian probability distribution, 708 
so the nearest pixels are more influential.  709 
 710 
2.2.4.2. Go optionally to Process > Math > Gamma with ticked Preview box to increase 711 
the contrast.  712 
 713 
NOTE: Intensities set in the B&C panel are scaled between the two min and max limits. Values 714 
< 1.0 accentuate differences between low intensities while values > 1.0 accentuate 715 
differences between high intensities. Gamma correction is functional to find a display range, 716 
showing the dimmest objects without saturating the brightest. 717 
 718 
2.2.5. Creation of a binary image mask.  719 
 720 
2.2.5.1. Go to Image > Adjust > Threshold. The most simply employed method to 721 
determine thresholds relies on histogram analysis of intensity levels, as shown in Figure 7F. 722 
In the drop-menu, play with different global thresholding methods (in our case, Otsu is 723 
applied).  724 
 725 
2.2.5.2. Manually scroll or type a known range of pixel intensities in the histogram 726 
panels, observe the change of the red pattern overlaying the image which mostly resembles 727 
the actual cell area. The Reset button removes the overlay. Once satisfied, click Apply to 728 
generate a binary version of the image. Check Process > Binary > Options to control how 729 
thresholded images are displayed and how objects are identified by the Particle Analyzer. 730 
 731 
2.2.6. Use the menu command Process/Binary/Watershed Particles to divide partially 732 
overlapping or merged during the threshold. Watershed can often accurately cut them apart 733 
by adding a 1-pixel thick line. Perform morphological operations such as Dilate or Erode 734 
operations to either grow or remove pixels from under or over- saturated pixels.  735 
 736 
NOTE: For more information see the Menu Commands section or refer to MorphoLibJ, an 737 
integrated library based on mathematical morphology to process binary data. 738 
 739 
2.2.7.  Quantitative Image Feature Description.  740 
 741 
2.2.7.1. Once obtained satisfactory object recognition, open the Particle Analyzer from 742 
Analyze > Analyze Particles. Particles can be excluded by their size and circularity, expressed 743 
in pixels or in a calibrated unit of measurement (check the correct scale relative to microscope 744 
settings under Image > Properties). To include everything, keep the default of 0-Infinity and 745 
circularity default range at 0.00 – 1.00 (0 = straight line, 1 = perfect circle).  746 
 747 
2.2.7.2. To filter small “noise” pixels or features of not interest, set the minimum and 748 
maximum range. Tick Include Holes, Show, Outline and Display Results options in the 749 
window field. Exclude on Edges will discard particles detected on the borders of the image. 750 
Add to Manager adds the obtained selection to the ROI manager for further analysis keeping 751 
the position information of the particle.  752 



   

 

 753 
NOTE: In the “ROI Manager”, it is possible to correct automatic segmentation recorded output 754 
(merge split cells, split merged cells). Select, by using selection tools in the Fiji Toolbar, ROIs 755 
inside both gel regions where cancer cells are embedded to estimate immune infiltration. 756 
 757 
2.2.8. Export the obtained values to a spreadsheet to perform statistical analysis as shown 758 
in Figure 7G. “Results” lists a data table relative to numbered outlined particle properties 759 
identified. “Summarize” opens a window with the name of the image, total counts, and other 760 
information for the whole image.  761 
 762 
2.2.8.1. Go to Analyze > Set Measurements to include a wide range of parameters. 763 
 764 
2.2.9. Record optionally a macro (by selecting Plugins > Macros > Record) to automate the 765 
processing workflow and save time analysis on large datasets.  766 
 767 
2.2.9.1. Use the same processing routine to analyze green fluorescence channel in the 768 
same regions for analyzing morphological changes of tumor cells in 3D regions16. 769 
 770 
REPRESENTATIVE RESULTS: 771 
Tumor immune infiltration is a parameter of the host anti-tumor response. Tumors are 772 
heterogeneous in the composition, density, location, and functional state of infiltrating 773 
leukocytes which interactions with cancer cells can underlie clinically relevant information to 774 
predict disease course and response to therapy. In this sense, microfluidic technologies could 775 
be used as complementary and privileged in vitro tools to explore the immune contexture of 776 
tumors, as well as to monitor the response to anticancer therapies. The coupling of the 777 
microfluidic assay, live-cell imaging, and tracking software may establish reliable 778 
quantification methods to quantify how immune cells adjust their migration pattern in 779 
different contexts. In this chapter, we have reported steps for setting up versatile 2D or 3D 780 
co-cultures of immune and target cancer cells in ad hoc microfluidic devices realized by 781 
standard soft-lithographic procedures. In Section 1 microfluidic devices were employed to 782 
allow chemical and physical contacts between adherent (MDA-MB-231 cancer cells) and non-783 
adherent (PBMCs) populations. Some chemotherapeutic agents (e.g., anthracyclines among 784 
the others) can induce "immunogenic" apoptosis of malignant cells, thus enhance their 785 
visibility in immunocompetent hosts. Cancer immunogenic cell death (ICD) is characterized 786 
by the release of membrane-bound and soluble signals delivered by dying cells functioning as 787 
alarmins for immune cells. To provide a quantitative validation of ICD response, we employ 788 
data collected in the microfluidic platform where leukocytes can move through suitably built 789 
microchannel bridges toward their target cells. Time-lapse recordings were performed after 790 
co-loading PBMCs, from healthy donors (WT, wild type), with human MDA-MB-231 breast 791 
cancer cells pre-treated or not with the anthracycline DOXO. Microphotographs were 792 
generated every 2 min, for two successive time intervals of 24 and 48 h. (Exemplary Movie S1 793 
of 0-24 h interval). Tracking analysis of individual PBMCs challenged with dying (DOXO-794 
treated) or live (PBS-treated) cancer cells was done using Trackmate plug-in, as seen in Figure 795 
6A (left panel). Relevant chemotaxis values and migration plots were automatically generated 796 
by using the Chemotaxis and Migration Tool, as detailed in62. The cell trajectories were all 797 
extrapolated to (x, y) = 0 at time 24 h. The results indicated a different migratory profile of 798 
the immune cells when co-loaded with breast cancer cells exposed to DOXO or PBS. When 799 



   

 

PBMCs were confronted with apoptotic cancer cells, they crossed microchannels towards 800 
dying/dead cells (but not to live untreated cells). Migration X/Y spider and rose plots, 801 
presented in left panel Figure 6B-C, were mapped and compared to highlight the impact of 802 
immunogenic inducers agents on differences in immune dynamics. Rose plots demonstrate 803 
that PBMCs migrated mainly in nearly all directions in the control experiment, only a 804 
negligible fraction is guided up the gradient generated by proliferating cancer cells. 805 
Conversely, the paths of individual cells highlight a strong bias movement along the direction 806 
of apoptotic breast cancer cells (negative x-direction). To evaluate directed immune cell 807 
migration towards DOXO-treated or PBS-treated cancer cells, tseveral chemotaxis parameters 808 
are computed, including: a) the center of mass (spatial averaged point of all endpoints); b) 809 
the directionality; c) the forward migration index (i.e., the average cell displacement in a 810 
direction of interest which means towards target tumor site, in our case). The latter values 811 
represent a measurement of the cell efficiency of a cell to migrate in the direction given 812 
chemotactic stimuli. After reaching the left chamber, a fraction of leukocytes with an 813 
increasing density over 24-48 h exhibited a long-term (>60 min) contacts with DOXO-treated 814 
MDA-MB-231. PBMCs fail to massively migrate and engage in such long-term and persistent 815 
interactions with live cancer cells (as shown by representative microphotographs of 816 
approaching PBMCs in Figure 6A, right). For quantifying differences in tumor-immune 817 
interplay, the tumor region was delineated with a fixed circle of diameter ranging 20-80 818 
microns, named “hotspot”. The quantification and analysis from representative FOVs are 819 
shown in Figure 6 (Right panel, B-C). 820 
 821 
In Section 2 a novel 3D immuno-competent tumor model was described to quantify the 822 
recruitment of immune cells in response to anti-cancer combinations of epigenetic drugs32 823 
(DAC/IFN vs IFN alone), allowing the comparison of two different treatment conditions of 824 
A375 melanoma cells simultaneously. Thus, A375M melanoma cells, labeled with PKH67 825 
green fluorescent dye were embedded in Matrigel matrices in the presence of DAC and/or 826 
IFN into each gel chamber, whereas PKH26 red-labeled PBMCs were distributed 827 
homogenously into the central fluidic chamber at the starting point (Figure 7A). We compared 828 
simultaneously the two tumor masses in 3D matrices for their capacity to attract PBMCs. At 829 
48 and 72 h, PBMCs are guided massively into the right-side microchannels, as observed in 830 
Figure 7B.  831 
 832 
A preferential homing of PBMCs toward the gel matrix containing DAC/IFN-treated, rather 833 
than IFN-treated, melanoma site was clearly observed, whereas poor migration rate was 834 
visible toward A375 cells exposed to single treatment (left chip side). The competitive setting 835 
is applicable to investigate a plethora of different cancer biology phenotypes (e.g., drug-836 
resistant vs aggressive, primary or metastatic (e.g., A375P vs A375M melanoma cells), and 837 
responders vs non-responders). Gel chambers can be comprised of complex co-cultures of 838 
malignant cells and multiple non-cancerous tumor-associated cells, such as endothelial cells, 839 
immune cells, and fibroblasts33 to characterize TME-level drug responses. Events of mitosis 840 
and apoptotic death of cancer cells can be monitored by staining with live dyes33. 841 
Immunostaining procedures on 3D microfluidic devices could be adapted to evaluate states 842 
of activation of infiltrated immune cells in tumor sites by confocal microscopy35. In this sense, 843 
these 3D microfluidic systems may mimic complex tumor structures and multicellular 844 
interactions and therefore are valuable platforms for more reliable preclinical drug testing.  845 
 846 

https://www.sciencedirect.com/topics/neuroscience/apoptosis


   

 

FIGURE AND TABLE LEGENDS:  847 
Figure 1. Planimetry of the microfluidic device for assembling 2D tumor-immune co-848 
cultures. (A) Real microphotograph of 3 chips assembled into a single microscope slide. The 849 
reservoirs are numbered depending on the loading sequence and are color-coded as the 850 
corresponding culture chambers listed in the legend. Scalebar, 6 mm. (B) Details of the narrow 851 
microgrooves bridge, showing the dimensions tailored to cancer cells and PBMCs size. C) 3D 852 
CAD of chip consisting of three main cell culture areas connected by microgrooves. D-E) 853 
Visible light microphotograph was acquired before the beginning of the time-lapse, showing 854 
the distribution of cancer cells and PBMCs respectively in the left and the intermediate 855 
chamber. Scalebar, 500 μm. 856 
 857 
Figure 2. Trackmate analysis pipeline for localization of immune spots in time-series images. 858 
A) Upper panel: Screenshot of Trackmate image calibration menu. Lower panel: Fiji “Image 859 
properties menu” to set time and spatial units. B) Upper panel: Screenshot of Trackmate 860 
image calibration menu. Lower panel: Output image with applied different values of 861 
“Threshold”. -C) Upper panel: Screenshot of Trackmate "Spot filtering” menu illustrating 862 
some filters. Lower panel: Exemplary time-lapse image, depicting immune spots filtered by 863 
position along X in the intermediate chamber. 864 
 865 
Figure 3. Trackmate Analysis pipeline for reconstructing immune tracks in time-series image 866 
sequences. A-C) Screenshots of Trackmate menus corresponding to detector selection for 867 
track building, track filtering, and to display menus for exporting final data. D) Examples of 868 
generated tracks in pre-processed time-lapse images varying the linking detector settings. E) 869 
Example of false tracks and bad links derived from the detection of tumor cells borders. F) 870 
Tracks are highlighted in green by selecting rows in the file .txt of results. 871 
 872 
Figure 4. Schematic overview for 3D immunocompetent tumor-on chips. A) Examples of 873 
micro-structured silicon master. Stamps for PDMS were patterned in SU-8 negative resist in a 874 
cleanroom facility equipped with e-beam and optical lithography. B) Polydimethylsiloxane 875 
(PDMS) replicas were fabricated by standard soft-lithography methods. The central unit has 876 
the chambers colored as the ones drawn in 3D rendering of the chip, depicted in the panel D. 877 
C) Scanning electron microscopy (SEM) enlarged view of the array of micropillars suited for 878 
hydrogel solution entrapment. D)3D CAD showing the chambers, connected by microgrooves 879 
and the loading wells. Dashed boxes are referred to SEM photographs of details (panel C, and 880 
E). E) SEM photograph of 10 μm high connecting microgrooves. F) 2D CAD layout depicting 881 
the dimensions of microstructures. 882 
 883 
Figure 5. Schematic workflow of main loading protocol steps for assembling 3D co-cultures. 884 
A) Upper panel: Schematics of injection step of Matrigel solution in each gel side region. 885 
Lower panel: Real photograph of the chip showing gel front advancement along the channel 886 
during loading step. B) Schematics of Matrigel polymerization step. Lower panel: Phase-887 
contrast microscopic view of the gel-air interface formed after gelation step. Scalebar, 100 888 
µm. C)Upper panel: Drawing, depicting the loading of cells and media with exemplary volumes 889 
used in the protocol. Lower panel: 4X Phase-contrast image of the assembled co-culture at 0h 890 
is shown in lower panel. Scalebar, 200 µm. 891 
 892 
Figure 6. Analysis of migratory profiles and interaction behavior of PBMC towards 893 



   

 

dying/live tumor chamber in the time window of 24-48 h. Left panel. A) Screenshots of time-894 
lapse pre-processed images overlaid with immune colored tracks, extracted by Trackmate. 895 
The immune paths are obtained by a single FOV in the indicated experimental conditions in 896 
the interval 24-to-48 h in the intermediate chamber. B-C) Representative migration tracks and 897 
rose plots of PBMCs cultivated in the two different conditions (n = 1550 PBMCs versus DOXO-898 
treated cancer cells, DOXO+ or n =1434 PBMCs versus control cancer cells, DOXO-). Each line 899 
inside x-y plots depicts a single PBMC trajectory and each circle represents the final position 900 
of a single cell with respect to the initial position. Starting points are set to (0,0) using a 901 
coordinate transformation. The coordinates and displacement of the center of mass of cell 902 
migration are displayed in the indicated experimental conditions. The center of mass 903 
coordinates and displacement (computed as average Euclidean distance for the X and Y 904 
components) provide indication of the average direction in which the group of cells primarily 905 
travelled and magnitude of the overall cell movement in condition groups. Blue and green 906 
lines respectively mark individual tracks by Euclidean distance value greater/smaller than a 907 
threshold value (100 µm). D) Scheme of numerical data extracted by a cell track. E-F) Box & 908 
Whiskers plot depicting respectively directionality (p<0,0001 Unpaired t test with Welch's 909 
correction) and FMI (p<0,0001 Unpaired t test with Welch's correction). The horizontal line in 910 
boxes represents median values. The FMI values are the average for all cell-tracks in each 911 
condition group. 912 
Right panel. A) Screenshots of Trackmate extracted ROIs showing differential interactions 913 
between PBMCs and DOXO or PBS-treated cancer cells. B) Time density of PBMCs around 914 
DOXO-treated or control MDA-MB-231 cancer cells. Number of PBMCs present into selected 915 
ROI around cancer cells for each condition. Values reported are the average over 9 selected 916 
ROI from a single time-lapse FOV. Cancer hotspots are defined in a ROI (80 µm on in diameter). 917 
Corresponding density heatmap is displayed. Dots represent mean number of cells calculated 918 
over 9 cancer hotspots at indicated time points. C) Distribution of times (min) of contacts for 919 
each experimental group. 920 
 921 
Figure 7. Preferential recruitment of PBMCs in response to DAC plus IFN drug combinations 922 
in a competitive 3D immuno-competent melanoma on chip model. A) Distribution of initially 923 
loaded PBMCs in the central chamber of microfluidic devices. Microphotographs are acquired 924 
by EVOS-FL fluorescence microscope during 0-72 h interval. Red fluorescence (PKH67-labeled 925 
cells) represents PBMCs from healthy donors. PKH67-labeled (green) human melanoma cells 926 
embedded in Matrigel containing single or double combinations treatments were plated in 927 
lateral chambers. B) A375 cells plus IFN on left versus A375 plus DAC/IFN on the right. 928 
Fluorescence images were shown at 72 h of co-culture. Discontinued yellow box depicts 929 
visibly massive recruitment in A375 plus DAC/IFN side. C) PBMC counts in four different ROIs 930 
from IFN chambers vs DAC+IFN chambers. Histograms represent cell counts +/- S.D.; heatmap 931 
enumerated values from each ROI. Scalebars, 200 µm. D-G) Schematics of segmentation and 932 
quantification steps of infiltrated PBMCs in gel matrices applied to single channel 933 
fluorescence images.  934 
 935 
Supplementary File. Microfabrication protocol 936 
 937 
Supplementary Movie 1. Time-lapses sequences in a 2D tumor-immune on-chip co-culture. 938 
Microphotographs were acquired every 2 min, in a time interval of 0-24 h by means of a smart 939 
Microscope into a standard cell culture incubator. Left panel. Movie of PBMCs from healthy 940 



   

 

donors (WT, wild type), plated with MDA-MB-231 control breast cancer cells. Right panel. 941 
Movie of a massive migration of PBMCs WT towards the chip chamber where MDA-MB-231 942 
DOXO-treated cancer cells, are loaded. 2D chip layout is described in detail in section 1of 943 
Protocol and shown in Figure 1. 944 
 945 
DISCUSSION 946 
The described methods try to design a general approach to recapitulate, with modulable 947 
degree of complexity, two significant aspects in the field of onco-immunology, which can 948 
benefit from the adoption of more relevant in vitro models. The first one involves the tumor 949 
cell population side, where tackling single cell characteristics may lead to a better description 950 
of heterogeneity and correlated biological and clinical significance including resistance to 951 
therapy, propension to metastasis, stem cell and differentiation grade. The other side of the 952 
story is represented by the TME, including noncancerous components (immune and stromal 953 
cells, blood vessels) and chemical/physical landscape (ECM constituents, chemokines and 954 
other soluble factors released) that can profoundly shape both the characteristics of the 955 
disease and individual’s response to therapy63, particularly to immunotherapy. It is worth to 956 
note that exporting the described approach to other research fields requires a deep 957 
understanding of limitations and challenges brought by the development and adoption of 958 
new models.  959 
 960 
Quoting a maxim applied in engineering modelling (“model the problem not the system”), it 961 
must be optimized which is the minimum number of (cellular, physical and chemical) 962 
components and conditions needed to make own on-chip model biologically relevant and 963 
stable along the whole experiment. Every combination of cell 964 
types/microenvironmental/experimental setting must, thus, be accurately chosen, evaluated, 965 
and continuously monitored along single experiments and from session to session. These 966 
checks include, as mentioned in the protocol sections, strict control of parameters like 967 
volumes in the microfluidic devices that can be modified by humidity conditions or heating 968 
from illumination sources, possible movements and non-planarity of stages causing 969 
uncontrolled liquid drifts, but also some endpoint verification of cell state, viability and 970 
phenotypic characterization. One critical step concerns the decision to use perfusion systems 971 
to create vascularized (like) structures, or for on-chip drug delivery33, since this may affect the 972 
experiments in terms of increasing complexity, cell culture duration, and modulation of the 973 
chemical factors in presence of floating cells like the immune ones.  974 
 975 
In the following, we summarize the main critical and relevant issues found in the experimental 976 
settings and in the most recent literature.  977 
 978 
ECM and chemical landscape definition  979 
TME is deeply affected also by the mechanical64,65 properties of the surroundings63, 66. For this 980 
reason, the choice of the culturing matrix is fundamental, especially when dealing with 981 
immune cells that, in certain conditions, could respond to signals released by the matrix itself. 982 
Relevant advances are expected in the next future also from design and development of new 983 
materials and hydrogels (featured by different stiffness, porosity, presence of soluble factors, 984 
among the other parameters) that are enabling an increasingly refined and controllable ECM, 985 
mimicking specificities of different tissues today, different patients tomorrow. On the other 986 
side is also critical to monitor the changes induced by the different cell populations in the 987 



   

 

ECM and define strategies to include this information in dynamic and phenotypic analyses.  988 
 989 
Data management 990 
The path toward deployment of tumor on-chip techniques in a clinical workflow is going to 991 
benefit from a huge experimental work that is taking place along several directions. Organ-992 
on-chip models, as many in vitro techniques, are functional, at least potentially, to perform 993 
high-throughput/high-content measurements. Parallelization of experimental conditions, 994 
including positive and negative controls, and technical/biological replicates is made possible 995 
by integrating several chips on the same plate. The increase in the quantitative throughput 996 
plays a crucial role in translating and validating these systems in fast drug or gene screening 997 
pipeline for immunotherapies. Indeed, several companies have already developed platforms 998 
in a multi-well format, and different imaging approaches are being tested to allow for 999 
monitoring a high number of devices simultaneously14. In the above described protocols, we 1000 
used microscope slides allocating up to 3 chips, with the possibility to visualize up to 12 1001 
experimental conditions in parallel, using a standard microscope multi-slide tray. This setup 1002 
is compatible with hand pipetting and suitable for custom oriented adjustments performed 1003 
in our microfabrication facility. On the contrary, when a strong parallelization is necessary 1004 
(multiple screening tests and controls), setup optimizations to set a higher level of automation 1005 
(i.e., use of pipetting robots, plastic multi-wells) are required. 1006 
 1007 
When designing experiments, a trade-off between spatial and temporal resolution must be 1008 
taken in account. 1009 
 1010 
The huge amount of data, produced by high content microscopy, constitutes a limiting factor 1011 
in terms of storage, transfer and analysis. These issues are being addressed with 1012 
computational approaches implementing machine learning tools and hardware/software 1013 
resources, which may foster the future possibility to link on-chip/in-silico experiments67,68 in 1014 
choosing therapeutic strategies, and that represents an ambitious yet non-deferrable 1015 
opportunity.  1016 
 1017 
Beyond Fluorescence Imaging 1018 
Fluorescence labelling, by dyes or reporter genes, due to its high specificity, undoubtedly 1019 
represents the gold standard method to identify different cell populations in co-culture 1020 
conditions and to resolve molecular properties with high SNR. In OOC models this approach 1021 
is commonly used as a reference and particularly in heterogeneous tumor-on-chip 1022 
microenvironments, it can be valuable to characterize the phenotype of immune cells 1023 
infiltrated and interacting. 1024 
 1025 
Nevertheless, there is increasing evidence that effects induced by fluorophores, laborious 1026 
staining procedures and illumination routines must be monitored and minimized69 because 1027 
can deeply affect cell behavior and state70,71. This risk seems particularly true for fragile 1028 
systems, such as immune cells72,73. Phototoxic reactions may introduce limitations in defining 1029 
the temporal window acquisition of live cells when monitored at high spatial and temporal 1030 
resolution. Moreover, the richness in the variety of immune sub-populations make unfeasible 1031 
to discriminate among them only by fluorescent staining, considering the limited number of 1032 
filters commonly available on microscopes. 1033 
 1034 



   

 

To address this issue, from an instrumental point of view, novel label free74 microscopy 1035 
techniques such as holographic56 or hyperspectral microscopy57 are now appearing on the 1036 
stage. They promise advanced cellular process classification strategies beyond fluorescence 1037 
and can be particularly valuable for studying sensitive samples. From a data analysis point of 1038 
view, advanced computational approaches, based on deep learning algorithms75 (trained by 1039 
fluorescence images datasets), are door-openers to perform the so called “in silico 1040 
labeling”76,77. They have been successfully applied to predict fluorescent markers from bright-1041 
field images78, generating labeled images, without staining cells, thus increasing bright field 1042 
microscopy informative power. This strategy can also be useful to save time and fluorescence 1043 
channels for other markers. We believe that OOC community will benefit from these new 1044 
techniques allowing a less invasive study of cell populations interaction.  1045 
 1046 
Data analysis  1047 
Mechanisms of interactions between immune and target cancer cells can be investigated 1048 
through tracking of cell movements28,79. Time-lapse tracking experiments in complex and 1049 
heterogeneous co-cultures are extremely valuable to extract cell migration patterns, 1050 
morphological and state changes, and comprehensive lineage information. Performing 1051 
manual analysis is practically only feasible for short sequences with few cells but not for high-1052 
throughput, systematic experiments. Consequently, the development of computational tools 1053 
for cell tracking, either fully or partly automated, is a vital field of research in image analysis24. 1054 
Typically, conventional cell tracking requires relatively high frequency of sampling and spatial 1055 
resolution to correctly perform segmentation tasks, which can be challenging in many 1056 
experimental conditions. To localize cells, there are available open-access segmentation and 1057 
tracking tools (e.g., ImageJ software22) as presented in this protocol or dedicated proprietary 1058 
software. In large-scale studies, we applied a proprietary software called Cell Hunter16,31, 1059 
developed by University of Tor Vergata in Rome, to distinguish in a fully automatic way cancer 1060 
and immune cells in multi-population context. Tailor-made solutions based on machine 1061 
learning and Neural network approaches80–82 are beginning to be today implemented in 1062 
microscopy software packages83, from improving SNR to managing critical acquisition 1063 
parameters or segmentation steps. Machine learning can be exploited to recognize common 1064 
cellular patterns (e.g., motion styles) in order to characterize the biological response with 1065 
respect to microenvironmental factors. 1066 
 1067 
In Comes et al.41, a pre-trained Deep Learning Convolutional Neural Network architecture was 1068 
applied to classify if cancer cells are or not exposed to a drug treatment by using as a “marker” 1069 
the motility of the immune cells, tracked from time-lapse data of co-cultures of breast cancer 1070 
cells and PBMCs in collagen matrices in microdevices, as described in33. 1071 
 1072 
Single-cell omics methods and ontologies development  1073 
We point out the need for a strategic alliance between single-cell omics technologies84 (e.g., 1074 
proteomics, metabolomics, genomics) and on-chip methods: the molecular detailed 1075 
characterization, conjugated to functional dynamic information could enhance 1076 
comprehension of basic mechanisms and clinical description. In this case new instruments for 1077 
linking the two worlds are at their beginning85. The first challenge is to implement single-cell 1078 
omics approaches directly on the onco-immunology chips22. Moreover, organ-on-chips could 1079 
be exploited as platforms to test potential targets identified by genomics and proteomics 1080 
analyses86,87. A second linking tool, which is still largely missing, is a structured, standardized 1081 
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way of annotating and storing measured system results88,89. But this is exactly what we need 1082 
in the future to build systematic databases of cellular quantitative results and measured 1083 
characteristics, to mine, infer and correlate them with the inherent biological information. In 1084 
a word, the need for standardization and systematic analysis of heterogeneous experimental 1085 
datasets calls for an ontology framework. 1086 
 1087 
Personalizing models  1088 
Organs-on-chip technology is suitable for personalization12, since cells and tissues from single 1089 
patients (or classes of patients) can be used in the devices under controlled conditions, 1090 
leading to clinically relevant readouts, useful to inform therapeutic or prevention strategies. 1091 
Some examples are starting to appear in literature90. Of course, for tumor-on-chip models, 1092 
this challenge poses several technical and scientific questions to be solved36 (like TME 1093 
characteristics control such as oxygen concentration, cytokine gradients, etc). Importantly, 1094 
the prospect of making oncology and onco-immunology therapies more effective while 1095 
reducing harmful effects for each patient is attractive, from a quality of life perspective as for 1096 
the optimization of healthcare resources.  1097 
 1098 
In conclusion, it is apparent that this field is an authentically interdisciplinary one and as such, 1099 
requires a great effort in establishing a common language and shared goals between 1100 
researcher, clinicians, industry, but also from different disciplines (engineering, biology, data 1101 
science, medicine, chemistry) finding good balance and new solutions91. 1102 
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Name of Material/ Equipment Company

Cell culture materials 

50 mL tubes Corning-Sigma Aldrich, St. Louis, MO

5-aza-2'-deoxycytidine DAC Millipore-Sigma; St. Louis, MO

6-well plates Corning-Sigma Aldrich, St. Louis, MO

75 cm2 cell culture treated flask Corning, New York, NY

A365M
American Type Culture Collection (ATCC), Manassas, VA

Doxorubicin hydrochloride Millipore-Sigma; St. Louis, MO

Dulbecco's Modified Eagle Medium DMEM EuroClone Spa, Milan, Italy

Dulbecco's Phosphate Buffer Saline w/o Calcium w/o Magnesium EuroClone Spa, Milan, Italy

Fetal Bovine Serum EuroClone Spa, Milan, Italy

Ficoll GE-Heathcare

hemocytometer Neubauer

Heparinized vials Thermo Fisher Scientific Inc., Waltham, MA

interferon alpha-2b Millipore-Sigma; St. Louis, MO

L-Glutamine 100X EuroClone Spa, Milan, Italy

Liquid nitrogen

Lympholyte cell separation media Cedarlane Labs, Burlington, Canada

Lymphoprep Axis-Shield PoC AS, Oslo, Norway

Matrigel Corning, New York, NY

MDA-MB-231 
American Type Culture Collection (ATCC), Manassas, VA

Penicillin/ Streptomycin 100X  EuroClone Spa, Milan, Italy

Pipet aid Drummond Scientific Co., Broomall, PA

PKH26 Red Fluorescent cell linker Millipore-Sigma; St. Louis, MO

PKH67 Green fluorescent cell linker Millipore-Sigma; St. Louis, MO

RPMI-1640 EuroClone Spa, Milan, Italy

serological pipettes (2 mL, 5 mL, 10 mL, 25 mL, 50 mL) Corning- Millipore-Sigma; St. Louis, MO

sterile tips (1-10 μL, 10-20 μL, 20-200 μL, 1000 μL) EuroClone Spa, Milan, Italy

Timer
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Trypan Blue solution Thermo Fisher Scientific Inc., Waltham, MA

Trypsin EuroClone Spa, Milan, Italy

Cell culture equipment

EVOS-FL fluorescence microscope Thermo Fisher Scientific Inc., Waltham, MA

Humified cell culture incubator Thermo Fisher Scientific Inc., Waltham, MA

Juli Microscope Nanoentek

Laboratory refrigerator (4 °C) FDM

Laboratory Safety Cabinet (Class II) Steril VBH 72 MP

Optical microscope Zeiss

Refrigerable centrifuge Beckman Coulter

Thermostatic bath

Microfabrication materials 

3-Aminopropyl)triethoxysilane (Aptes) Sigma Aldrich

Chromium quartz masks / 4"x4", HRC / No AZ MB W&A,  Germany

Glass coverslip, D 263 M Schott glass,  (170 ± 5 µm) Ibidi, Germany

Hydrogen Peroxide solution 30% Carlo Erba Reagents

Methyl isobutyl ketone Carlo Erba Reagents

Microscope Glass Slides (Pack of 50 slides) 76.2 mm x 25.4 mm 
Sail Brand

Miltex Biopsy Punch with Plunger, ID 1.0mm Tedpella

PMMA  950 kDa Allresist,Germany

Polymer untreated coverslips Ibidi, Germany

Prime CZ-Si Wafer,  4”, (100), Boron Doped Gambetti Xenologia Srl, Italy

Propan-2-ol Carlo Erba Reagents

Propylene glycol monomethyl ether acetate (PGMEA) Sigma Aldrich

SU-8 3005 Micro resist technology,Germany

SU-8 3050 Micro resist technology,Germany

Suite of Biopunch, ID 4.0 mm, 6.0 mm, 8.0 mm Tedpella

Sulfuric acid 96% Carlo Erba Reagents

SYLGARD 184 Silicone Elastomer Kit Dowsil, Dow Corning



Trimethylchlorosilane (TMCS) Sigma Aldrich

Microfabrication equipment

100 kV e-beam litography Raith-Vistec EBPG 5HR

hotplate

Optical litography system EV-420 double-face contact mask-aligner

Reactive Ion Etching system Oxford plasmalab 80 plus system

Vacuum dessicator



Catalog Number Comments/Description

CLS430828 centrifuge tubes

A3656 DNA-hypomethylating agent

CLS3506 culture dishes

430641U culture flasks

	CVCL_B222
human melanoma cell line

D1515 anthracycline antibiotic 

ECM0728L Culture medium for SK-MEL-28  cells

ECB4004L saline buffer solution

ECS0180L ancillary for cell culture

17-1440-02 separation of mononuclear cells from human blood. 

Cell counter

Vials for venous blood collection

SRP4595 recombinant human cytokine

ECB3000D ancillary for cell culture

Separation of lymphocytes by density gradient centrifugation

354230 growth factor reduced basement membrane matrix

 HTB-26 human breast cancer cell line

ECB3001D ancillary for cell culture

4-000-201 Liquid handling

PKH26GL red fluorescent cell dye

PKH67GL green fluorescent cell dye

ECM2001L Culture medium for MDA-MB-231 cells

CLS4486; CLS4487; CLS4488; CLS4489; CLS4490 Liquid handling

ECTD00010; ECTD00020; ECTD00200; ECTD01005 tips for micropipette

https://www.sigmaaldrich.com/catalog/product/sigma/a3656?lang=it&region=IT
https://www.sigmaaldrich.com/catalog/product/sigma/pkh26gl?lang=it&region=IT
https://www.sigmaaldrich.com/catalog/product/sigma/pkh67gl?lang=it&region=IT


15250061 cell stain to assess cell viability

ECM0920D dissociation reagent for adherent cells

Fluorescent microscope for living cells

311 Forma Direct Heat COIncubator; TC 230 Incubation of cell cultures at 37 °C, 5% CO2

Laminar flow hood

A3648 silanizing agent for bonding PDMS to plastic coverslip

optical masks for photolithography

10812

412081 reagents for piranha solution

461945 PMMA e-beam resist developer

7101 substrates for bonding chips

dermal biopsy punches for chip reservoirs

AR-P. 679.04 Positive electronic resists for patterning optical masks

10813 substrates for bonding chips

30255

415238

484431-4L SU-8 resists developer

C1.02.003-0001 Negative Photoresists

C1.02.003-0005 Negative Photoresists

15111-40, 15111-60, 15111-80 dermal biopsy punches for chip reservoirs

410381 reagents for piranha solution

11-3184-01 Silicone Elastomer (PDMS)



92360-100ML silanizing agent for SU-8 patterned masters



 

We would like to thank the reviewers and the editor for their in-depth reading of our paper and for 

comments that allowed us to identify unclear aspects of the paper, to go deeper in some details of the 

illustrated workflow, and highlight critical aspects of the protocols, yet clarifying the potentialities of 

the approach. After significant revision, we believe that the manuscript has been improved both in 

completeness and clarity. You will find the answers to your comments in this point-by-point response, 

and major changes highlighted (in red) in the text of the paper. 

Reply to the editorial comments: 

Changes to be made by the Author(s): 

1. Please take this opportunity to thoroughly proofread the manuscript to ensure that there are no 

spelling or grammar issues. 

The whole manuscript has been proofread; we think that the overall language quality has been 

improved. 

 

2. Unfortunately, there are sections of the manuscript that show overlap with previously published 

work. Please revise the following lines: 806-814, 833-839 

All the sections have been revised, and lines 806-814, 833-839 rewritten. 

 

3. How is the supplemental video to be used? Please provide a legend for it in the manuscript. 

A legend for the supplemental video showing exemplary co-cultures of tumor cells and 

PBMCs in the 2D chip setting has been added. The rationale is to use it for the preparation of 

the video of the protocol in Jove. 

 

4. Please ensure that all text in the protocol section is written in the imperative tense as if telling 

someone how to do the technique (e.g., “Do this,” “Ensure that,” etc.). The actions should be 

described in the imperative tense in complete sentences wherever possible. Avoid usage of phrases 

such as “could be,” “should be,” and “would be” throughout the Protocol. 

All sections of the protocol now include only action items.  

 

5. The Protocol should contain only action items that direct the reader to do something. Please move 

the discussion about the protocol to the Discussion. 

Additional text is included now as a note or transferred to the Discussion.  

 

6. Please highlight up to 3 pages of the Protocol (including headings and spacing) that identifies the 

essential steps of the protocol for the video, i.e., the steps that should be visualized to tell the most 

cohesive story of the Protocol. Remember that non-highlighted Protocol steps will remain in the 

manuscript, and therefore will still be available to the reader. 

We have provided the requested additional pages that illustrate the essential steps of the 

protocol for the video. 
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7. Please ensure that the highlighted steps form a cohesive narrative with a logical flow from one 

highlighted step to the next. Please highlight complete sentences (not parts of sentences). Please 

ensure that the highlighted part of the step includes at least one action that is written in imperative 

As suggested by reviewers’ comments we have added a supplementary file to describe steps 

of fabrication, from the realization of optical masks, and masters for soft lithography to the 

production of final PDMS chips. 
 

Reviewers' comments: 

Please note that page and line numbers mentioned hereafter refer to our revised manuscript and not 

to the original paper. The changed and added texts are shown in red.  

____________________________ 

Reviewer #1: 

Manuscript Summary: 

The authors describe a novel organ-on-chip approach to investigate the interaction between tumor 

and immune cells in in vitro tumor microenvironment. They show two different devices to create 2D 

or 3D co-cultures in order to study the immune response toward tumor. It is well written and data are 

clearly present. 

Minor Concerns: 

1. The authors point out in part 1 relating to the 2D device that "fresh media should be added every 3 

days due to evaporation". This note should also be added in Part 2 related on 3D devices, indeed the 

evaporation could lead to variations in the volume of medium in the chip. 

Authors’ response: We agree with the reviewer, evaporation indeed represents one of the critical 

issues to be monitored in organs on chip experiments. As suggested, we have added a note in section 

2, step 1.12 (lines 507-508). 

 

2. The authors should discuss if it is possible to analyse in the chip: the phenotype, the functional 

status of the migrated immune cells and the chemokines released in order to evaluate the mechanism 

of tumor and immune cell interaction. 

Authors’ response: We thank the referee to go in depth with this point of discussion. There are 

indeed several methods to characterize cellular populations in cocultures. 

To characterize their dynamic behavior in living conditions, specific immune cell sub-populations 

can be isolated by means of immunomagnetic bead selection, stained with fluorescent cell trackers or 

by gene reporters, re-mixed with the unlabeled remaining fraction, and thus confronted with target 

cancer cells, as reported in on-chip experiments, described in Vacchelli et al. Science 2015 and in 

Racioppi et al., Nat Comm, 2019. A note has been provided in section 1 ( paragraph “Plating the cells 

in 2D chips”, page 4, lines 208-2012). 

 



The described models are compatible both with live/dead-cell analysis and dynamic multiplex 

cytokine secretion profiling from conditioned media. For chemokine analyses, up to 100-250 µl 

aliquots of supernatants may be accessible by collected media from the two reservoirs of each 

compartment for 2D and 3D chips. Classical ELISA and Luminex cytokine profiling assay require 

about 50µl volumes. We have inserted references of studies of other labs performing cytokine 

profiling on organs-on chip models. We have inserted a note in section 1, step 2.7, page 5 , lines 242-

247.  

Staining for nuclear and active caspases, by using commercial kits for Live/dead assays (e.g  Incucyte 

reagents), can be implemented in order to assess proliferation/apoptotic death events as we performed 

in a previous study (reported in Nyugen et al., Cell Reports 2018). We have inserted a note in section 

2, page 9, lines 445-447. 

Additionally, classical methods of immunofluorescence and confocal high-resolution 

imaging/analysis can be applied to on-chip operations. Standard immunofluorescence staining 

procedure involves cell fixation, permeabilization, blocking, antibody binding, with washing steps in 

between. Immune cells infiltrated in 3D gels regions with embedded cancer microenvironments can 

be fixed at desired endpoints and stained for expression markers of activation/exhaustion /maturation 

(e.g, for CD8 cells, monitoring of CD69, CD95). In Parlato et al., we have evaluated phagocytosis of 

SW620 apoptotic cells by confocal microscopy.  IFN-DCs were stained by inserting on-chip anti-

human HLA-DR-FITC Ab aliquots. We have inserted a note in section 2  page 11 , lines 513-521. 

 

Reviewer #2: 

Manuscript Summary: 

In-vitro models that recapture the tumor microenvironment in their entirety or include critical 

components of the tumor including the stroma, immune and non-immune cells are the need of the 

hour. While it's important to develop such models, it's even more essential to demonstrate its 

functionality and validity to the scientific community. Detailed protocol articles like the current one 

under review make it easier for fellow researchers to reproduce and adapt the methodology into their 

own projects and laboratories. The article is written very well and clear instructions are provided for 

each step with figures. 

Major Concerns: 

No major concerns 

Minor Concerns: 

None 

Authors’ response: We thank the referee for appreciating our work. 

Reviewer #3: 

The authors developed a microfluidic technique that allows the coculture of cancer cells with immune 

cells to capture their interaction both in 2D and in 3D. The data were quantified following a Fiji-

based algorithm to visualize cellular functions. A protocol for the technique is clearly explained. The 

article should be published after the following comments are addressed: 

1. Line 156 should read 1.1, not 4.1. 



Authors’ response: The numbers in the list are now correct (in the revised text, page 4, line 167). 

2. In part 1.25, the authors may want to indicate the media that was used (or that it is the same media 

used for the cancer cells).  

 

Authors’ response: We now specify in the text (section 1, step 1.25, page 4, line 203) that the media 

is the same used for cancer cells. 

 

3. Is there a technique the authors employ to inhibit the formation of bubbles within the microfluidic 

device?  

Authors’ response: In the described protocols, 2D and 3D chips are realized in Polydimethylsiloxane 

(PDMS). The surface of PDMS is naturally hydrophobic. To modify wettability, oxygen plasma 

activation is the standard method used for both its switching to a hydrophilic state and the irreversible 

PDMS-substrate (i.e., glass or plastic slides) bonding. Typically, our process involves high gas 

pressures and low RF (radiofrequency) power, in a reactive ion etcher (RIE) If needed, before 

biological experiments, we perform an additional O2 plasma treatment of stored assembled, 

previously sealed, chips to restore the desired hydrophilicity degree. This is normally sufficient to 

avoid bubble formation during culture medium loading. We have added an additional step (section 1, 

step 2.1, page 4, lines 214-219) in the protocol relative to 2D chips in the manuscript. Moreover, we 

have provided details for surface modification of both 2D and 3D chips in the supplementary file 

dedicated to microfabrication steps (step 7). 

 

4. In part 2.2, the authors specified that functionalizations of the surface can be made. It may be 

useful to provide examples and how to perform such functionalizations. 

Authors’ response: Various polymer and extracellular matrices (e.g., Matrigel, Fibronectin, 

Collagen) coating solutions can be used for different cell types under study. Standard 

functionalization procedures include loading surface coating solution in all reservoirs for a certain 

time, followed by some washes in with deionized water, PBS or medium. We included in the text 

references of previously published protocols to accomplish functionalization steps in section 1, step 

2.4, lines 229-231. 

 

5. What are the proper dimensions for the micropillars to ensure a balance between surface tension 

and capillary forces?   

Authors’ response:  For the 3D chip layout, we designed two arrays of about 20-30 isosceles 

trapezoidal pillars with a spacing of 100 microns. Post barriers were tested empirically based on 

previous work of CP. Huang et al., Lab on Chip 2009. We have reported dimensions in a note, in 

section 2 (page,9 line 432-434) and added proper references of previous studies relative to modeling 

the filling process of gels in microchambers in presence of micropillars. 

 



6. Line 405 should have the abbreviations spelled out.  

Authors’ response: We have transferred this note in lines and now the drugs abbreviations have 

been spelled out firstly in step 1.2, lines 462-463. 

7. In line 459, the authors mention that adjustments should be made if the distribution of cells is not 

optimal; would these adjustments need to be made on a new chip? A clarification would be useful. 

Authors’ response: In the paper we now clearly state to use always new chips (steps 1.10, lines 501-

503). We also suggest considering having a 10%-20% more spare chips respect to the number of 

conditions to be monitored. 

 

8. The paragraph starting in line 750 is unclear.  

Authors’ response: We changed the sentence in the Discussion, page 18, line 823. 

9. The different improvements to the system broken up per section is a nice touch to the manuscript. 

Authors’ response: We thank the reviewer for appreciating the configuration of the paper. 

 

10. For publication, ensure the red underlines under the words in the figure are not present.   

Authors’ response: We corrected the problem. 

   

11. In Figure 2C, why does the mean intensity increase from left to right (the color changes from blue 

to red)? Is this an artifact of the microscope?  

Authors’ response: We thank the reviewer for detecting this error. The old panel (label “mean 

intensity” in the drop menu) has been replaced with the correct screenshot (filter label in the drop-

menu: X) of Trackmate menu in the revised Fig.2 The spots in the image shown in the Fig.2C, 

highlighted in the intermediate chamber of 2D chip are color-coded, depending on their position along 

X (in this example, immune cells, surrounded by blue circles are nearby the microchannels entrance). 

We have now specified in the caption of Fig.2. 

 

12. The caption for Figure 3E does not include D nor E. Please include a sentence on each to clarify 

what is being shown.  

 

Authors’ response: We have corrected captions in D and E, wrongly indicated in the previous text 

by F and G. 

 

13. There are various typographical errors throughout the manuscript that need to be fixed.  



Authors’ response: We have corrected various typographical errors and improved the revised 

manuscript. We would like to apologize for some of these lapses.  

 

 

Reviewer #4: 

Manuscript Summary: 

This manuscript contains detailed protocols for tumor on-a-chip experiments. The authors are 

pioneers and experts in the field. These protocols will be very useful for other laboratories. 

 

Major Concerns: 

None 

 

Minor Concerns: 

1) Page 2, lines 105-106: A reference is needed after "This allowed us to characterize immune 

responses to cancer cells treated or not with immunogenic cell death inducers." 

Authors’ response: We introduced the associated reference in the Introduction, line 106. 

2) Page 3, line 146. What do the numbers in "500x12x10 μm3" stand for? Please specify.  

Authors’ response: The text now includes specifications about size units in page 3, line 155. 

3) In the protocols, technical details about chip design and construction should be provided so that 

other laboratories can produce or order identical chips.  

Authors’ response: Since chip fabrication protocol is similar to already published protocols in jove, 

we added the necessary references and the technical details to fabricate both 2D and 3D chips (from 

realization of photomasks, and SU-8 patterned masters to final assembled chips) a  supplementary 

material. 

4) Page 3, lines 146-147: "intermediate channel". Do the authors mean "intermediate chamber" 

instead?  

Authors’ response:  We replaced the text as follow “The intermediate chamber forms two closed 

dead-end compartments which block floating immune cells overflowing into the tumor site when 

initially loaded” (page 3, line 156) 

5) Catalog numbers should be provided for all reagents used in the protocols.  

Authors’ response: Now all catalog numbers of reagents/materials appear correctly in the revised 

version of the table “Jove Materials”.  

6) "IFN" is a confusing abbreviation because there are many types of interferons with different 

properties. The authors should specific with a Greek letter throughout the manuscript which exact 

interferon they refer to (alpha, beta, gamma, etc).  



Authors’ response: We modified the text to clarify the acronym’s usage as follows: ‘Where 

indicated, add 5-aza-2'-deoxycytidine (DAC; 2.5 μM), referred to as DAC, and/or IFN-α2b, 

referred to as IFN, at the proper doses’’.  

The use of IFN-alpha is indicated in section 2, page 10, step.1.2, line 462.  

 

7) Page 13, line 597: "The results, strongly indicated" should be corrected to "The results indicated".  

Authors’ response: We have modified the sentence as suggested (page 14, line 629). 

8) Page 13, line 604: negletible. Negligible, I suppose?   

Authors’ response: We revised the whole paper to correct this and (hopefully) all other misspellings.  

 9) Page 17, line 756. The authors state that "the choice of the culturing matrix is fundamental" 

without being more specific. Which culturing matrix and chip material would the authors currently 

recommend for tumor on-a-chip experiments?  

Authors’ response: We thank the reviewer for pointing out this point that is relevant in the definition 

of the experimental protocol. We added the necessary information and references in the text (page 

10, step 1.1, line 457-459). We clarified that in the presented 3D model we did use Matrigel due to 

its ability to promote cell growth and self-organization, but in other models we successfully used 

collagen I. This is a rapidly evolving field, and an increasing number of hydrogels is being designed, 

produced and tested for specific models in organ on chip and organoid environment.  

As detailed also in microfabrication section (supplementary file), the material used for the chip is 

PDMS, widely used as standard material with soft-lithography protocols and for its compatibility 

with cell culture.  

 

10) Page 18, lines 795-803. The authors state that "immune cells are could be heavily perturbed by 

time-consuming, complex and expensive staining procedures" and apparently recommend "the usage 

of label free observation of the immune system". It is a surprising recommendation which would 

imply a significant limitation of this technique. If many different cell types are added to a chip recreate 

in vitro a tumor microenvironment, it will be essential to be able to identify the different cell types 

during an experiment. Although labeling procedures have limitations such as toxicity, they are widely 

used for in vitro live imaging experiments. It is hard to believe that cell labeling could not be used 

on-a-chip. This important technical point needs clarification.  

Authors’ response: We thank the reviewer for the possibility to better explain this point. 

Fluorescence labeling, due to its high specificity, undoubtedly represents a gold standard method to 

identify different cell populations in co-culture conditions, and in OOC models this approach is 

commonly used as a reference. However, when dealing with immune cells, extra care must be taken 

to avoid perturbing effects induced by fluorophore molecules and illumination routines, that can 

deeply affect cell behavior and state. Moreover, the maximum number of simultaneous fluorescent 

colorations available, could constitute a limiting factor in the observation of multi cell-type contexts 

exploited in OOC experiments. In this context an increasing number of researches are dealing on 

classification and recognition of different cell type/activity using Artificial Intelligence based image 

analysis and/or different optical approaches.   



In the revised Discussion section, named "Beyond Fluorescence Imaging” (page 19, lines 863-887) 

we list some emerging possibilities, which we think will be fruitfully included in OOC workflow in 

the next future to complement the use of fluorescence imaging. In particular we refer to both 

directions: the exploitation of new imaging approaches (e.g., hyperspectral, holographic), and the 

adoption of machine learning methods, such as ones providing strategies (trained by fluorescence 

images datasets), to perform the so called ‘’in silico labeling’’, applied to predict fluorescent markers 

from bright-field images, promising a good classification accuracy without actual labelling of cells.  

.  

 

11) Page 18, line 821. What exactly do the authors mean by "omics". Please specify.  

Authors’ response: We better specified this point in the text by referring to single-cell omics 

techniques in page 20, lines 916. 

 

Reviewer #5: 

Manuscript Summary: 

The authors describe a microfluidic platform for co-culture of cancer cells with stromal cells and 

show immune targeting in response to various treatments. The authors also describe their image 

processing methods. 

 

Major Concerns: 

5.1 The authors highlight the use of fluorescence microscopy in the tracking of cells in the 

microfluidic platform, yet the video they provide is brightfield only. Fluorescence time-lapse 

microscopy is warranted and would be helpful to include in order to visually differentiate between 

the cancer cells and the immune cells in the platform. 

A viability marker would be useful to show the cancer cell death. 

Authors’ response: 

We thank the reviewer for providing opportunity to clarify better the rationale of having two different 

sections. We have now revised the abstract to introduce more clearly this aspect (lines 38-49). In the 

paper we provide protocols relative to two distinct microfluidic assays, for assembling respectively 

2D (Fig.1A), and 3D (Fig.4A) co-cultures of tumor and immune cells. In 2D setting we performed 

visible light time-lapse movies of unlabeled co-cultures. In the 3D setting we monitored immune 

infiltration towards tumor cells cultivated in 3D regions, acquiring only fluorescence snapshots at 

specific endpoints (thus not videos).  

  and  We detailed in Discussion paragraph (page 19, lines 863-887), advantages, limitations, and 

challenges of fluorescence- based methods in OOC imaging strategies, indicating some developments 

in label free techniques that will match fruitfully with multi cell-type contexts such OOC models and 

we inserted explicit references to previous work from our and other groups 

  



Concerning the theme of compatibility with commercial kits for Live/dead assays for live-cell 

imaging, we explicitly added a note in the protocol section 2 (page 9, lines 445-448), and linked 

references to other studies from our group  describing  the possibility to perform on-chip staining for 

nuclear and active caspases to assess proliferation/apoptotic death events .  

 

5.2 In the video, it is not clear what the difference between the two 'PBMC WT' panels is, and this 

is also not described in the text. 

Authors’ response: We inserted the missing caption for the supplementary movie (0-24h interval) 

(page 17, line 764-770].  In the caption and in Results (Fig.6, lines 613-651) is now clearly described 

the difference among the panels:  PBMCs extracted from healthy donors (WT, wild type), were plated 

with human MDA-MB-231 breast cancer cells, non-treated or exposed to DOX (an immunogenic cell 

death inducer, ICD). In the second case, PBMC’s migration appears clearly, while in the non-treated 

case they are poorly or not attracted by proliferating untreated cancer cells (left panel movie). 

5.3 I would suggest for the video, to include a walk-through of your image processing software. There 

are many steps and options, so to have that portion visualized for the user would be exceptionally 

helpful. 

Authors’ response: We thank the referee for the valuable suggestion for the making of the video. 

5.4 Chip fabrication steps are not included here but needed in order to carry out experiments. This 

also has implications for imaging - what is the focal length of the chip bottom? Are the devices arrayed 

for high throughput experiments? How many devices can you feasibly load and run at a time? This 

also has a bearing on the feasibility for AI integration.  

Authors’ response: As discussed in the response to reviewer 4 point 3, we did include details of chip 

fabrication, from the realization of optical masks, and masters for soft lithography to the production 

of final PDMS chips as supplementary material.  

For the throughput point, typically 3 chips are arranged on a single microscope slide (Fig.1A for 2D 

chip, 4A for 3D chip). So, it is possible to monitor up to 12 chips, using holders allocating 4 slides 

by high-content microscopy (e.g. Operetta imaging systems, Molecular devices, ImageXpress 

systems) to increase batches of experimental conditions. Chips can be easily mounted on slides with 

thickness equal to 1mm or 170 microns (plastic or glass coverslips, 6-well optical multi-wells) for 

high-resolution confocal imaging. We have inserted in the revised manuscript a specific note in page 

5, line 250-255 and discussed the throughput point in the paragraph Data Management of Discussion 

(lines 840-854). 

Additionally, as strategy to keep compatibility with automated acquisition routines of high-content 

microscopes, we have introduced detailed steps in the supplementary file “microfabrication protocol” 

(page 3, step 6 of the supp file). Typically, we realize markers on glass or plastic slides (to which 

PDMS chips will be bonded) by laser cut systems. Markers are used to align slides, in a standardized 

way, with respect to PDMS chips. This aids to integrate chips in automated imaging settings. 

5.5 The use of artificial intelligence is mentioned, however specific examples of how AI can be 

leveraged in the proposed context are missing. AI requires large datasets, and it is not clear from the 

article how the technology will either integrate or generate large datasets to leverage AI algorithms. 



Please describe with concrete examples how you plan to move forward with AI in the current context, 

since this is only peripherally alluded to in the text. 

 

Authors’ response: We agree with the reviewer that this point was poorly tackled in the previous 

version of the paper. We expanded the discussion and added, where relevant, a description of the 

potential contributions of AI schemes in OOC data analysis: 

1) “in silico labeling’’ to predict fluorescent markers from bright-field images. This can also be 

suitable to reduce photodamage for sensitive samples, to save time in acquisition and fluorescence 

channels for other markers, particularly useful in contexts such as multi-cell type OOC models. (page 

20, lines 881-887). 

2)  from managing critical imaging acquisition parameters to improving image segmentation steps, 

such as implemented in microscopy software packages (page 20, lines 904-906).  

3) Recognition of common cellular patterns (e.g., motion styles) in order to characterize the biological 

response with respect to microenvironmental factors. Such an example of potentiality of this point, 

we reported the study, described in Comes et al., Scientific Reports,2020, regarding the classification 

of immune patterns, extracted from time-lapse data of 3D co-cultures of cancer cells and PBMCs in 

our microdevices (page 20, lines 910-913). 

 

5.6 It is not clear to me why there are two sections and two seemingly distinct script programs that 

appear to be doing similar processes. I would consider integrating '4 Data analysis: Semi-automatic 

extraction of immune tracks by Trackmate' and '2 Automated Counting of recruited PBMCs in single 

channel fluorescent images in ImageJ' into a single package. It states that Trackmate can process 

fluorescent images, so why the separate section for fluorescent images? This is not clear to me from 

the text. Please plainly state the difference if there is one or merge the two sections into one section 

on image processing toward the end of the text if possible. 

Authors’ response: We improved the paper to clarify the need for the two different sections stressing 

the different experimental approaches and data analysis of the two different scenarios as additive or 

complementary modules of the OOC approach in the onco-immunology field (in the Abstract, and in 

the Introduction lines 93-132).  

In the section 1 we describe a system where adherent cells (tumor cells) and floating cells (immune 

cells) interact to recapitulate immune response to cancer immunogenic inducers and were imaged by 

time-lapse bright-field microscopy with short time interval (2min) up to 48h. In this case we present 

the semi-automatic analysis pipeline based on Trackmate to build tracks of unlabeled immune cells, 

and to process motility and interaction patterns.  

In the section 2 the contribution describes the use of a novel chip to recreate tumor-immune 

microenvironments in 3D gels in a ’’competition layout”. Differential migration of immune cells 

towards two compartments hosting tumoral cells that have undergone different treatments can be 

monitored and quantified. For the image analysis point of view, we acquired fluorescence snapshots 

of stained PBMCs in some ROIs (not time-lapse videos with short time interval) at 0h, 24h, 48h,72h. 

We extract counts (not tracks) of labeled PBMCs infiltrated in 3D matrices with embedded tumor 

cells. Therefore, we described segmentation steps for fluorescence images and subsequent counting 

by Analyze plugin in Image J. Of course, in case of fluorescent time-lapse series, Trackmate 

procedure (as in the section1) can be applied. 



 

Minor Concerns: 

Please cite protocols that have already been extensively published (e.g. PBMC isolation). 

Authors’ response: We have introduced reference to protocols in lines  

Please consider referencing the work of Christopher Hughes, Don Ingber and Roger Kamm. 

Authors’ response: We have introduced a reference for the vascularized tumor platform developed 

by C.Hughes (line 90) and added several citations to D.Ingber (ref 13,14,86) and R.Kamm works in 

the revised manuscript (line 90, ref. 19-21, ref. 61). 

There are many grammatical errors and the list below is not a comprehensive list of the errors found 

in the manuscript. 

Authors’ response: We would like to apologize for the several errors, and we revised extensively 

the manuscript to improve clarity and correctness. 

99 - not clear what is intended in this sentence, as it states 'a microfluidic device thought to'. Do you 

think it does this or is this something you've shown? Statement doesn't read as scientific. 

Authors’ response: We replaced by term designed (page 2, line 99). 

107 - what is meant by 'long-term' here? How long can these be cultured/imaged? 

Authors’ response: We modified by timeseries images. In the described experiments, we monitored 

co-cultures in microfluidic devices (2D or 3D settings) up to 48-72 hours.  

114 - Please define what A375M and A375P are and what is the difference. 

Authors’ response: A375M are a metastatic melanoma cell line while A375P are a primary 

melanoma cell line. We have explained the difference in the revised version of the Introduction (page 

2, lines 117-120). 

116-118 - Have you shown cells derived from these sources to work in this platform? If so, please 

provide references. 

Authors’ response: The section 2 of the protocol (3D setting) involves the use of human A365M 

melanoma cell lines in Matrigel exposed to combinations of therapeutic agents, and primary 

peripheral blood mononuclear cells (PBMCs) from healthy donors. Despite the A375P primary cell 

line, A375M was chosen to evaluate their metastatic capability in presence of immune cells. We have 

provided the associated reference in page 2, line 120. As highlighted in the introduction, the 

developed models can be fully compliant with different cell sources (i.e., murine and human 

immortalized or primary cell lines, organoids, xenografts). We inserted references (lines 101-102, 

and lines 124-132) of several published works of our lab in the introduction. 

120 - Which ADCC is being tested? 

Authors’ response: In our previous study, (reported in Nguyen et al. Cell Reports 20x 18) we have 

reconstituted ex vivo a human tumor ecosystem (HER2+ breast cancer) in the presence of the drug 

trastuzumab (Herceptin), a targeted antibody therapy directed against the HER2 receptor. We 

demonstrated that the presence of trastuzumab, in addition to inhibiting cancer cell proliferation and 

stimulating cancer cell death as expected, increased cancer-immune interactions and induced an anti-



tumoral ADCC immune response. We have changed the text to add more details (page 2, lines 125-

126).   

 

Authors’ response: We have fixed the following errors, according to suggestions. 

Methods 3.1 - stating the power should be left on while warming up the microscope is not needed 

(goes without saying) 

574 - response to therapy needs a period after 

598 - should be 'exposed to DOXO or non-treated' 

620 - close parentheses 

731 - should be stress, not stress out 

737 - on chip should be on-chip 

830 - this is not a complete sentence… 

840 - it is, not is 

841 - requires, not is required 

 

  

 

 

 

  

 

 

 



Supplementary file  
Microfabrication protocol of PDMS chips  
 
Polydimethylsiloxane (PDMS, Sylgard 184 kit, Dowsil), microfluidic assays for 2D (Fig.1, PART1) and 
3D (Fig.4B, PART2) layout have been manifactured by well-known soft-lithographic procedures, as 
described in detail previously, in a clean room facility or foundry, equipped with micro- and 
nanoscale instrumentations (e-beam lithography, photolithography and thin-film technology, nano-
diagnostic tools). NOTE: In the absence of clean room services, there are different companies on the 
market to order patterned optical masks or masters for PDMS soft-lithography. 
Steps can be summarized briefly in the points below: 
1. Fabrication of optical masks. NOTE: For both 2D and 3D chips two photomasks have been 

patterned by transferring CAD drawings containing layers respectively of culture chambers and 
microchannels with alignment marks. 
1.1. Spin PMMA (AR-P. 679.04, Allresist, Germany) positive electronic resist on chromium 

photomasks (MB W&A, Germany) at 2000rpm for 60sec. 
1.2. Pre-bake on a hotplate at 170°C for 5 min. 
1.3. Expose by 100 kV e-beam lithography. NOTE: E-beam (Raith-Vistec EBPG 5HR system) 

settings are the following: 650µC/cm2 resist dose and 90nA   e-beam current. 
1.4. Develop in MIBK: IPA = 1:1 (Methyl isobutyl ketone: Propan-2-ol, Carlo Erba reagents) for 

30-60sec and rinse in IPA 
1.5. Place optical mask in a RIE (Reactive Ion Etching) chamber to perform O2 plasma etch for 30 

sec. 
1.6. Remove remaining chromium film in Cr etching acid solution for 2 min. 

2. Fabrication of a microstructured epoxy resin mould, referred to, as ‘’master’’. NOTE: Both 2D 
and 3D layout are patterned using two different i-line (365 nm, EV-420 mask-aligner) optical 
lithography onto the SU-8 3000 series negative sensitive epoxy resins (micro resist technology 
GmbH, Germany). 
2.1. Spin SU-8 3005 at 1000 rpm for 60sec to reach a thickness of about 10 microns. 
2.2. Pre-bake at 95°C for3 min. Choose post-bake temperatures and time according to 

manifacture datasheet. 

2.3. Expose the wafer to UV light through optical mask (4-5sec, 12.9mW/cm2, EV-420 double-
face contact mask-aligner) 

2.4. Post-bake at 65°C for 1 min and at 95°C for 2 min. 

2.5. Develop in PGMEA solution (Propylene glycol monomethyl ether acetate, Sigma Aldrich) 
and rinse in IPA for 10min. 

2.6. Hard-bake the wafer at 150°C for 30min. 
2.7. Spin SU-8 3050 resin to expose cell culture chambers to reach a desired thickness (1000 rpm 

for 30sec for 2D 100µm-high culture chambers, depicted in Fig.1) 
2.8. Pre-bake the wafer according to datasheet. 

2.9. NOTE: For 3D chip layout (Fig.4), repeat steps 2.7 and 2.8 twice to obtain a thickness range 

of 250-260µm (first spinning step: 2000 rpm for 30sec, second spinning step: 1100 rpm for 

30sec) 

2.10. Expose (17sec,12.9mW/cm2, EV-420 double-face contact mask-aligner). 
2.11. Execute post-bake of the wafer according to datasheet. 
2.12. Develop in PGMEA solution and rinse in IPA. 
2.13. Hard-bake the wafer at 150°C for 1h. 

3. Dry silanization of SU-8 micro-structured master. 

Supplemental File (Figures, Permissions, etc.) Click here to access/download;Supplemental File (Figures,
Permissions, etc.);Supp_file_microfabrication_protocol.docx

https://www.editorialmanager.com/jove/download.aspx?id=1254293&guid=d97f8557-8c26-4181-bfff-efdd28eea81d&scheme=1
https://www.editorialmanager.com/jove/download.aspx?id=1254293&guid=d97f8557-8c26-4181-bfff-efdd28eea81d&scheme=1


3.1. Inside a ventilated chemical fume hood put few drops of the silanizing agent 

(Trimethylchlorosilane, TMCS, Sigma Aldrich) in a cup and place the O2 plasma pre-treated 

master over it in a vacuum dessicator. Keep them under vacuum for different hours or 

overnight. Note: During this process, TMCS evaporates and forms a monolayer on master 

surfaces to prevent PDMS sticking on its features. Note: Wear safety glasses, gloves and 

face protection. 

3.2. Place the wafer on the hotplate in the fume hood 150°C for 10-15 mins to cure and 
evaporate the excessive silane. 

4. Casting of PDMS liquid solution on microstructured master 
4.1. Degas prepolimer solution (10:1 v/v, monomer: curing agent mixing ratio) contained in a 

plastic cup in a vacuum dessicator for 30 minutes. 

4.2. Remove any dust on the surface of the silicon wafer by using a nitrogen gun with a 0.45 µm 

filter. 

4.3. Pour slowly PDMS solution over the master avoiding bubbles. Leave it under hood for 10 
min at room temperature (RT) before baking.  

4.4. Crosslink PDMS thermally for 1h 30 min at 110 °C on a hotplate. Let it cool. 
4.5. Detach carefully from the silanized master with a surgical blade and tweezers. Cut 

polimerized pieces in desired sizes and punch reservoirs (access ports for introducing cells 
and media) by dermal biopsy tools (Tedpella). Use 6 mm biopsy punches to create wells in 
the 2D layout, while for 3D layout drill respectively 4mm (media reservoirs) and 1mm-sized 
holes (gel inlets ) . 

5. PDMS structure irreversible sealing to cell culture substrates by O2 plasma treatment 
5.1. PDMS-glass bonding. 

5.1.1. Put PDMS chips (with patterned side facing up) along with the glass slides inside the 

RIE chamber (Oxford Plasmalab 80 plus system) at the following RIE settings: 20W (RF 

power), flux of 60 standard cc/minute, 800-mTorr (pressure), and 30 sec (time). Note: 

Optimize process parameters according to your plasma cleaner machine. 

5.1.2. Bring into conformal contact the treated surfaces of the glass slide and PDMS device 

(channels side faced down) with each other at a clean bench.  Check under an optical 

microscope the quality of bonding. Note: PDMS can be mounted on glass microscope 

slides (1mm thick), glass coverslips (170µm thick) and optical bottom 6-multiwells. 

5.1.3. Bake on a hotplate at 80-90 °C for 2 h, to improve adhesion strength. To restore 

hydrophobicity in 3D culture chips, keep for more than 4 hours at same temperature. 

Store chips in sterile Petri dishes. 

5.2. PDMS-plastic bonding. 

5.2.1. Inside the fume hood, put few drops of the silanizing agent (3-Aminopropyl) 

triethoxysilane APTES, Sigma Aldrich) in a cup and place the O2 plasma pre-treated 

polymer coverslips (Ibidi, Germany) over it in a vacuum dessicator. Keep them under 

vacuum for 1-2 hours.  

5.2.2. Put into contact the silanized coverslip and pre-oxidized PDMS piece to assemble final 

device. Keep them in an oven or on a hotplate at 60-65°C for some hours. 

6. Compatibility with the automated acquisition software for high-content microscopy. Note: 
Markers for aligning PDMS chips are defined by laser writing system (Trotec Speedy 100 laser 
cut with 35W maximum laser power). 
6.1.1. Holder Fabrication. In order to load and write quickly the markers on your glass or 

plastic substrate, use the laser cutter to realize a holder for the microscope slides (12 



in our example). Use as material to fabricate holder Plexiglas 5mm thick (50cm x 30cm 
foil). Note: Alternatively, use a 5mm thick Plexiglas foil for the holder’s base and a 2mm 
thick foil for the holder’s cover. 

6.1.2. Cut two rectangles of 25cm x 21 cm (Laser Power 90%, speed 0,40cm/s, air ON, 
repetition rate 2000 Hz). Reduce power to 60% if you use 2mm thick plexiglass foils. 

6.1.2.1. Holder base (first rectangle), open 8 hexagonal holes to insert nuts 1cm apart 
from the borders on each side of the rectangle (size of the holes according to you 
nuts); You’ll have to glue your nuts in the holes once you remove the Plexiglas 
from the laser cutting machine. 

6.1.2.2. Holder Cover (second rectangle), open six holes to insert bolts in the same 
positions on the rectangle that you used for the nuts’ seating. Open 12 (6x6) 
rectangular windows of the same size of your microscope slides or coverslips 
(25mmx75mm in our case). Take care that these windows are placed at least at 
2cm from the holder sides and 1cm distant from each other. 

6.1.2.3. Holder assembly: Use 8 bolts to screw together the cover and the base 
6.2. Marker definition.  

6.2.1. Prepare the drawing for the markers to be engraved on the glass slides or coverslips 
considering their position in the holder you realized in step 6.1, so that they’ll match 
the ones on the chips. Note: Realize suitable markers in your PDMS chip layout 
fabrication. In our case we defined two crosses 2mmx2mm in the empty space between 
chips on the SU-8 master to replicate on the final PDMS chip. 

6.2.2. Insert your microscope slides in the rectangular seating in the holder. 
6.2.3. Place the holder inside the laser cutting machine, taking care to have it aligned with 

the machine axis and set the origin of your cut on the upper left holder’s corner. 
6.2.4. Engrave the markers with parameter suitable for the material that you are using. 

Note: Settings for glass slides are: Power 60%, speed 15mm/s, repetition 500Hz; for 
plastic (COC or polycarbonate) slides are: Power 30%, speed 40mm/s, repetition 500Hz. 

6.2.5. If some white powder is deposited during the process, clean it with a soft cloth and 
Isopropanol after having unmounted the substrates form the holder. 

7. Hydrophilic surface functionalization of chips before starting biological experiments. 

7.1. 2D layout (Fig 1A). To insert easily medium in culture chambers, oxygen plasma activate the 
assembled PDMS/culture substrates in the RIE chamber for 20-30 seconds.  

7.2. 3D layout (Fig 2A). Optionally perform selective oxidation of central immune chamber ina 
plasma cleaner for 5-10 seconds. This will make the chamber hydrophilic preventing 
formation of bubbles during loading. Note: Cover gel ports and media channels reservoirs 
(e.g, by Kapton tape) to guarantee the correct gel matrix positioning by micropillars array 
and avoid leakage in adjacent chambers. Gel regions have to be kept hydrophobic. 


